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ABSTRACT

This report is about an Information Display Console (IDC) project that is to be used by

each lecturer in Universiti Teknologi PETRONAS (UTP). The purpose of this IDC is to

give information to students or lecturers while the particular lecturer is away and to

enhance the professionalism in communication among lecturers and students.

The system consists of two parts. Firstly is the transmitter which is connected to a

computer via parallel port. Second part is the receiver to which a Liquid Crystal Display

(LCD) is attached. The system uses the infrared communication in transmitting data that

need to be updated. The data will be stored in a memory and will be displayed

continuously. The users can use a computer with its user interface to update the new

data. The development of the project involves designing and implementing the

hardware and the software. In the hardware part, it discusses the circuit design including

the calculation. In the software part, it discusses the process of developing the graphical

user interface (GUI), which is to be used in the system. The discussion on testing and

debugging the system are also included.

The system is a pioneer system in UTP since it uses new design in hardware and

software development. With this successful prototype development, it is envisioned that

lectures can enhance their professionalism in communication. Perhaps the system could

be deployed in UTP widely.
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ABBREVIATIONS AND NOMENCLATURES

IDC: Information Display Console

I2C: Inter-Integrated Circuit

LCD: Liquid Crystal Display

LED: Light Emitting Diode

MFC: Microsoft Foundation Class

PC: Personal Computer

SCL: Clock Signal Line (Serial CLock)
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SIRCS: SONY Infra Red Coding System



CHAPTER 1

INTRODUCTION

The Information Display Console (IDC) will display several items such as the lecturer's

name, extension number, consultation hours (Day/Time), class session

(Day/Time/Venue), test conducted (Day/Date/Time/Venue), and away message (where

the lecturer can be reached if he/she is away). The console will be located at each

lecturer's room. Thus, students or anybody can easily know where to find the lecturer if

the lecturer is away even if it is during the consultation hours. The students also can

know that their lecturer is having a class or has to be away from office.

The IDC will display the stored data to the Liquid Crystal Display (LCD) continuously.

The data will be updated only when there is a transmission of data to the IDC. To

updatethe data, the users need to transmitthe data from the Personal Computer (PC).

1.1 Background of Study

For this project there are several knowledge areas to be mastered. These are:

1. The principles of the micro controller

2. Inter-Integrated Circuit (I2C) Protocol

3. Parallel protocol

4. Infrared protocol

5. Microsoft Foundation Class (Visual C++) programming

6. Basic circuit theories



1.2 Problem Statement

There is a problem in which students want to meet a lecturer b ut t he 1ecturer i s n ot

around even, perhaps, during his/her consultation hours. The students might wonder

why the lecturer is not around, whether the lecturer is having a class or has an

emergency case. Thus, with this IDC the lecturer could put a message on it telling

others that he/she is not around and leave some message. Besides, the lecturer can put

on his/her schedule time or any relevance items. Also, the IDC can reduce the use of

paper.

1.3 Objectives and Scope of Study

The objectives of the project are:

1. Give information to students or lecturers while the particular lecturer is away

2. To enhance the professionalism in communication among lecturers and students

3. To minimize the use ofpaper

The scope that has to be covered is:

1. PIC16F871/PIC16F84 assembly language programming

2. LCD protocol

3. I2C protocol

4. Infrared protocol

5. Basic circuit theories

6. Parallel protocol

7. Microsoft Foundation Class (Visual C++) programming



CHAPTER 2

LITERATURE REVIEW

In completing the project, some application on LCD and infrared have been referred

from the internet [1], [4] & [5]. While the knowledge of programming the micro

controller, interfacing the Non-Volatile Memory (NVM), interfacing the LCD, infrared

protocol (SONY Infra Red Coding System = SIRCS) and developing software using

Microsoft Foundation Class (MFC) were acquired during the industrial training in

SONY Technology (M) Sdn. Bhd. Bangi. While doing the training, one project (LCC

Project) has been performed that dealt with PIC16F871 and the NVM. Based on this

experience, the knowledge is adapted to this project. Many of the assembly language
sourcecoderegardinginterfacingtheNVMandtheLCDwere developed during the

internship program under the supervision ofthe plant supervisor. The source code used

in this project is derivedfrom those codes.

The following are the theory of Inter-Integrated Circuit (I2C) protocol, LCD protocol,
Infrared,Parallel port and microcontroller.

2.1 Inter-Integrated Circuit

Inter-Integrated Circuit (I2C) protocol was originally developed as a control bus for
linking microcontroller and peripheral ICs for Phillips consumer product. It is two wire

bus combining address and data bus. The bus data rate is 100kbps [2].

I2C Features:

a. Resistant to glitches and noise

b. Supported by a large and diverse range ofperipheral devices

c. A well-known robust protocol



d. A long track record in the field

e. A respectable communication distance

f. Compatibility with a number of processor with integrated I C port

g. Easily emulated in software by any microcontroller

h. Available from a number of component manufacturer

I C Terminology

a. Transmitter

b. Receiver

c. Master

d. Slave

e. SDA - Data Signal Line (Serial DAta)

f. SCL - Clock Signal Line (Serial CLock)

Terminology for bus transfer

a. F (FREE) - the bus is free, SDA and SCL are in HIGH state

b. S (START) - data transfer begins with a start condition. The SDA is going

from HIGH to LOW, while the SCL remains HIGH

c. C (CHANGE) - while the SCL is LOW, the data bit to be transferred can be

applied to the SDA data line be a transmitter. During this time, SDA may

change it's state as long as the SCL line remains LOW

d. D (DATA) - a HIGH or LOW bit of information on the SDA line data line is

valid during the HIGH level of the SCL clock line. This level must be

maintained stable during the entire time that the clock remains HIGH to avoid

misinterpretationas a START and STOP condition

e. P (STOP) - data transfer is terminated by a STOP condition (not a stop bit).

This occurs when the level on the SDA Data line passes from LOW state to

HIGH state, while the SCL clock line remains HIGH. When the data transfer

has been terminated, the bus is free once again



Figure 2.1 shows the I C bus protocol [3].
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FIGURE 2.1:I2C Bus Protocol

ACK

STOP

CONDITION

I2C Operations [3]

a. Write Operation

Master sends a START condition to the slave. Following the START condition

the master sends device select code with the R/*W bit reset to '0'. The slave then

acknowledges this and waits for a byte address. Then the master sends the byte

address and followed by acknowledged by slave. This sequence is repeated for

multibyte write. Then the master sends STOP condition to terminate the

communication. Figure 2.2 shows the write mode sequence.
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FIGURE 2.2: Write Mode Sequence

b. Read Operation

The read operation is as shown in Figure 2.3.
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FIGURE 2.3: Read Mode Sequence
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2.2 Infrared

When adapting the remote control system on equipment, the following shall be obeyed

in order to actualize intercontrol between products and to prevent malfunction in

between Sony products, other companies' equipment by the Sony commander, or

malfunction of Sony's remote commander bythe other company's remote commander

1. Generally, SIRCS shallbe used for remote controlsystem

2. If it is functions, the characteristics of the products cannot be actualized, system

other that SIRCS can be adopted. In this case, confirmation of the following

shall be made:

a. There shall be no malfunction between its system and products of SIRCS

system, products with remote control system in Sony adopted formerly,

or remote control in other company

b. Regulations, ministerial ordinance, etc, shall be satisfied

3. Products supplied by OEM from other companies should adopt the SIRCS

system. Sony's products must be operated by Sony's uni-commander (system

commander). Other company's commander should notoperate Sony's product.

4. When a Sony's product is supplied to other company's product with its brand,

SIRCS system should not be used as far as possible. If any problem arise using

SIRCS system, it should be dealt by their responsibility



Guide Pulse and Bit Format

The guide pulse and bit format of the remote control signal shall be as follows (12-bit

format)

Glide

LTLT

FIGURE 2.4: Infrared Modulated Signal

FIGURE 2.5: Timing Diagram

TABLE 2.1: Time duration for each single bit
Symbol Time (ms) Tolerance (ms)

Duration of Guidepulse t2 2.4 +/-0.015

Data bit OFF time toff 0.6 +/-0.015

Data bit ON time

«i«

tonl 1.2 +/- 0.015

"0" toriO 0.6 +/- 0.015

Width of data bit
411 11

Tl 1.8 +/- 0.03

"0" TO 1.2 +/- 0.03

Frame period tf 45.0 +/- 1.2

Figure 2.6, illustrates the SIRCS protocol [5]. This protocol is standard protocol used by

Sony's remote control system. Base on this concept, some modification has been made



where the device code is eliminated. Thus, the protocol left the start pulse and the

command code.

1V.jrl C uninumJ ( i J,- Dcmlv Cudc

yipno D\x>i \y\\>.\ D5 DnCofTl Cj'c^k4
gflft ' 1.2or0.0iiiS ' '• 1 2 or ".tun's

FIGURE 2.6: SIRCS Protocol

2.3 Parallel Port

The original IBM-PC's Parallel Printer Port had a total of 12 digitaloutputs and

5 digital inputs accessed via 3 consecutive 8-bit ports in the processor's I/O space [7].

• 8 output pins accessed via the DATA Port

• 5 input pins (one inverted) accessed via the STATUS Port

• 4 output pins (three inverted) accessedvia the CONTROL Port

• The remaining 8 pins are grounded

FIGURE 2.7: Parallel Pinout



2.4 Microcontroller

The microcontrollers used are PIC16F871 and PIC16F84. The features of this device

can be found in datasheet [10 & 11].

2.5 Encoding and Decoding Infrared

The Sony Infra Red Coding System (SIRCS) was referred back to recap the pulse width

modulation system that is being used.

Thus, Figure 2.4 shows how the data bit '1' and '0' is modulated with 38 kHz carrier.

The ON state duration is showed in Table 1. The guidepulse is assumed as startpulse

and it has 2.4mS ON state, data bit T has 1.2mS ON state and data bit '0' has 0.6mS

ON state. The width of data bit '1' is 1.8mS and databit '0' is \ .2mS as shown in

Figure 2.5.

Note that the output from the filter is inHIGH state and it goes LOW state when there is

an input. Thus, the filter will outputs such that: data bit T will has LOW state for a

duration of 1.2mS, data bit '0' will has LOW state for duration of 0.6mS as shown in

Figure 2.8. Same goes to the startpulse where ithas LOW state for duration of2.4mS.

10



Data bit '1' Data bit '0'

1.2mS 0.6mS

Modulated Signal

Data bit T Data bit'0'

1.2mS 0.6mS

Filtered Signal

Figure 2.8: Modulated and Filtered Signal for data bit'!' and '0'

Theoretically, the input and the output should appear as shown in Figure 2.8.

Practically, the input for the filter (modulated signal) can be generated as shown. The

problem rise when it comes to the output of the filter which, it has a delay of some

millisecond. Thus, the calculation in determination of data bit '1' and '0' cannot take

the theory value. It must be modified in such that it takes into account the delay time.

The calculation for determination of data bit T and '0' is based on the transition from

HIGH to LOW and from LOW to HIGH of the filter output. The idea is that, the

microcontroller starts counting when there is a transition from HIGH to LOW. It stops

counting when there is a transition from LOW to HIGH. If the calculated value is less

than or equal to the theory value, thus the microcontroller will decode the transmitted

data accordingly.

Let's take the example of determination of data bit '0'. It has 0.6mS LOW state

duration. First, it has to determine the theory value of 0.6ms (in decimal). Let say the

microcontroller will start count when the transition occur (HIGH to LOW). It will keep

counting with increase by one for every lOuS until there is a transition from LOW to

HIGH. Final value will be 60 decimal: (0.6mS/10uS = 60), data bit '1' (1.2mS/10uS =

120), startpulse (2.4mS/10uS = 240). These are the theory value. Since the output of the

11



filter having some millisecond of delay, the theory value has been modified such that

data bit '0' takes 80 decimal, data bit Ttakes 130 decimal, and startpulse takes 240

decimal as a tolerance of the filter output.

Back to the determination of data bit '0'. Now it has modified theory value of 80

decimal. When data bit '0' appear in the filter output, the microcontroller start to count.

The final value then will be compared to the theory value. If it has less or equal to 80,

then the microcontroller will decode the signal as data bit '0'. This routine same goes to

determination o f d ata b it' V and s tartpulse. O ne feature h as b een added which is an

error detection signal. The error signal is defined as having the value of less than 60

decimal. This, feature is added since there is another source of infra red from the

atmosphere. Thus with this feature, it helps to prevent the microcontroller from

response to the infra red signal from atmosphere.

12



CHAPTER 3

METHODOLOGY

There are two processes, which need to be taken in completing the projects. Those

processes include procedure identification and tool identification. This process is

important to make sure the project is completed smoothly. Procedure identification

includes the steps need to be done in completion of the project while tool identification

lists all the tools needed in this project.

3.1 Procedure Identification

Steps involved:

1. Identifying, searching and gathering materials involve

a. Acquiring datasheets

i. PIC16F871

ii. PIC16F84

iii. ST24C08-Serial8K(lKx8)EEPROM

iv. Transistor (2N3904 & 2N3906)

v. LCD User Manual

vi. IS1U60/IS1U60L - Sensor with 1-Package Design of Remote

Control Detecting Function

b. Acquiring source code

i, LCD Functions Code

ii. I2C Functions Code

13



2. Understanding the material (datasheets)

i. PIC16F871 - microcontroller descriptions, pin descriptions, function of

register, instruction code used, electrical characteristics

ii. PIC16F84 - microcontroller descriptions, pin descriptions, function of

register, instruction code used, electrical characteristics

iii. ST24C08 - description, pin descriptions, device operation, electrical

characteristics

iv. 2N3904/2N3906 - pin description, electrical characteristics

v. LCD User Manual - pin descriptions, instruction sets, electrical

characteristics

3. Identifying, designing, and implementing the hardware needed (receiver

and transmitter)

The hardware designed and implemented were the receiver, transmitter with

parallel receptacle.

i. Receiver

The receiver part consists of PIC16F871 micro controller, the 24C08R

memory, LCD display, and IR receiver. The interface was based on the

electrical characteristics of respective components such as the micro

controller, 24C08R memory and the LCD. The characteristics are, the V0h,

Vih, V0l,Vil, Iih, Iil, Ioh, Iol, for every components mentioned before.

Since all the characteristics are met by each component, therefore the

components are connected directly. The schematic circuit is shown in

Figure 3.1.

14



vcc vcc
. 5y 5V

VCC vcc

Figure 3.1: Receiver Schematic

ii. Transmitter

The transmitter with parallel receptacle consists of buffer (74LS245N),

PIC16F84 microcontroller, parallel receptacle and infra red LED.

The determination of connection for this circuit is the same as the receiver

which is based on the electrical characteristics of the components

For the switching ON and OFF of the infra red LED, extra circuit is

needed

LED characteristics:

Vp(max) —1.7 V

VR(max) = 5V

lF(max)= 100 mA

2N3904 transistor characteristics

ON characteristics

Hfe = 30 ; Ic = 100 mA; VCE = 1-0V

Resistance value, Rb and Re

15



Calculation:

5-Vce-IcRc^O

5-1.0V-(100mA)Rc = 0

Rc - 40 Q

lB = fc/hfe = 100mA/ 30

Vitl-VBE-lBRB-0

4.3 V - 0.7V - (3.3333mA)RB = 0

RB = 1080Q~lkQ

The schematic circuit is shown in Figure 3.2.

VCC .* VDD w

From ParaUel Port

Figure 3.2: Transmitter (parallel) Schematic

16
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4. Program the PIC16F871 - displaying character, read from and write onto

memory

The source code that has been developed will be displaying

character/sentence. The character to be displayed is obtained from a memory.

This microcontroller must display the character read from a memory

continuously. At the same time it must be able to handle an interrupt when the

users want to update any information in the memory. The code consists of

main routine as well as the interrupt service routine that perform the required

job. Note that the main code performs displaying character continuously.

While the interrupt service routine will interrupt the main routine and acquire

updated data, then storing onto a memory. The source code is attached in

Appendix A. Some features have been added to the receiver which is the LED

indicator for the ease of debugging. There are two LED's have been added

(red and orange). Red LED indicates an error in writing or reading process

from a memory or if the memory is not working. While the orange LED

indicates the process ofdownloading data.

The source code is written in *.asm file. The software used is MPLAB. To

begin write the code the following step is applied:

1. Start the MPLAB software

2. From the toolbar click Project»New. Fill the project's name and save

it in respective folder. Then, click OK.

3. From the toolbar, click File»New. Then click File»Save. Save the

file sisfilename.asm in therespective folder. Then, click OK.

4. From the toolbar, click Project»Edit Project. Dialog window will

appears. Click Add Node. Selectfilename.asm. Then, click OK

5. Now, the code is ready to be written and compiled.

17



After the code has been written, it needs to be downloaded to the PIC chip.

The steps are as follow:

Before downloading the code, make sure the warp13 hardware is connected to

the serial port.

1. From the toolbar, click PICprogrammer»Enable Programmer

2. Dialogwindows will appear. Select the respective microcontroller in

processor box.

3. Click Program. Another dialog window will appear. The codehas been

successfullydownloaded after the dialog windows disappear.

4. Now, the code has been downloaded.

In storing the data, the receiver must agree with the transmitter. Which is the

receiver is expecting the Start Block to be received first followed by data

block. Here the data block type is used to storing the data in the memory. In

this case, instead of using address to storing the data, it is using block type as

indicator to store the data at certain particular location. Thus, the receiver must

check the value of datab lock (represent b y b inaryc ode) and then s tore the

data block according at its location (e.g Name Block will be stored in name

location). Table 3.1 illustrates how data is stored in the memory

18



Table 3.1: Memory Map

Page AO

00 01 02 03 04 05 06 07 08 09 OA OB OC OD OE OF

00 L e c t u r e r

10 M 0 h d Z u k I

20 E X t N 0 7 8 0 7

30 C 1 a s s S e s s i 0 n

40 S 1 0 t 1 M i c r 0 P

50 M 0 n 9 0 0 - 1 1 0 0

60 2 2 - 0 2 - 1 7

70 S 1 0 t 2 M i c r 0 P

80 w e d 1 0 0 0 - 1 2 0 0

90 2 2 - 0 2 - 1 7

AO C 0 n s t H 0 u r

BO M 0 n 1 4 0 0 - 1 5 0 0

CO T h u 9 0 0 - 1 0 0 0

DO

EO

FO

Table 3.1 continue

Page A2
00 01 02 03 04 05 06 07 08 09 OA OB OC OD OE OF

00 T e s t

10 C 0 u r s e

20 D a y T i m e

30 D a t e

40 V e n u e

50 A w a V M e s s a g e

60

70

80

90

AO

BO

CO

DO

EO

FO

19



The memory consists of 4 pages which each page can be occupied with 256

bytes. For this project only two pages is used. The page is designated as AO,

A2, A4, A6.

From Table 3.1 it can be visualized how the data is stored. Note that the Page

AO and A2 is the address of the memory. The number at the upper row and the

most left column is the subaddress. Thus, to read on the particular location, it

needs to specifythe page address followed by subaddress. While to write onto

the location it needs the page address followed by subaddress and followed by

data to be written.

5. Testing the hardware as well as the code - the circuit connection is correct

and the code should perform the sequence

In testing the hardware (receiver and transmitter) occur no problems or no

short circuit. For the receiver, the LCD connection has no problem. The

microcontroller is being able to perform the main routine as well as the

interrupt service routine. In debugging the main routine, it is expected to read

character form a memory and display the character. If it displays the correct

character, thus, the main routine does not have any error. In debugging the

interrupt routine, one interrupt signal is used to interrupt the microcontroller. It

is expected to exit from main routine andperform the interrupt service routine.

In both debug processes, both routines appear no error.

6. Program the PIC16F84 for manipulate data from parallel port and send

(generating) using infra red protocol

The microcontroller gets the data from the PC, and then transmits the data

using infrared protocol. The source code is attached in Appendix B. In

transmitting the data, there are two processes must be undergone. First process

is passing a value from a computer to the microcontroller via parallel port.

Secondly, the microcontroller transmits the data to the receiver. The idea in
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transmitting the data is that, data is transmitted using block. Thus, before

transmitting data block, it must send the start block.

In passing the value from a PC to the microcontroller, a simple protocol has

been developed. The protocol is illustrated in Figure 3.3.

S DATAO P S DATA1 P S S DATA/z P

FIGURE 3.3: Data Block

The protocol will start with start bit (S), then follow by DATAO and stop bit

(P). Then it repeats until DATAw. Then the PC needs to wait for the

transmitter to transmit the Data Block before it sends new Data Block. Before

the Data Block is sent, the Start Block must be sent first. This Start Block

indicates the type of Data Block, number of Data Block to be sent, and the

numberof byte in the Data Block. The StartBlock is illustratedin Figure3.4.

S BLK TYPE P S No ofBLK P S No of BYTE P

FIGURE 3.4: Start Block

In generating the infrared protocol, modified SIRCS is used to transmit a

character (1 byte). Figure 3.5 illustrates the modified SIRCS protocolcalled as

IDC Infrared Protocol.

Dak! (. ll.iMik't

l)i'l»l|U?|l)" l)4'l)5 IHi d;

1.2ur').fun,N

FIGURE 3.5: IDC Infrared Protocol

In transmitting the data, the transmitter follows the same protocol which is it

must transmit Start Block followed by Data Block, hi this case, the data is
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transmitted seriallyvia infrared. Now, the IDC Infrared Protocol is applied. It

will transmit Start Pulse followed by one character (8 bits). If there is n

character to be transmitted, it follows the same protocol which it starts send

Start Pulse follows by a character and it is repeating until all n character is

transmitted. After all blocks have been transmitted, the transmitter will send

the Stop Block to indicate the end of the transmission process. The Stop Block

consist the Stop Byte. Table 3.2 show the Hex value for each block type.

TABLE 3.2: Hex Code for Each Block

Hex Code Block Type Hex Code Block Type
OOh Lect ODh Day3
Olh Ext OEh Time3

02h Slotl OFh Const2

03h Course 1 lOh Day4
04h Dayl llh Time4

05h Timel 12h Test

06h Venue1 13h Course5

07h Slot2 14h Day5
08h Course2 15h Date

09h Day2 16h Time5

OAh Time2 17h Venue5

OBh Venue2 18h AwyMsg
OCh Constl AAh Stop

7. Testing the transmitter hardware - the circuit connection is correct and

be able to transmit the infrared protocol

The transmitter does not have any problem in connection and be able to

transmit or emit the infrared. The confirmation of the signal transmitted was

verified using oscilloscope. The main routine developed for the transmitter

should be able to generate the IDC Infrared Protocol signal. The signal

observed in debugging process is the Start Pulse, data bit ' 1' signal and data

bit '0' signal. If those signals are generated according to the timing diagram in

Figure 2.5, thus the main routine for the transmitter is correct and just need

some manipulation in transmitting a sequence on data bit T and '0'.
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8. Developing the software - take an input from user, pass to the micro

controller via parallel port

The Visual C++ (Microsoft Foundation Class - MFC) is one of the

applications in Visual C++. In this application the Windows for graphical user

interface (GUI) has been developed by this program. For this application it

uses the dialog based windows. After developing this Windows, the

programmer can add any control buttons on this Windows and add any

functions code in its source code file.

The variables must be declared as m_variablename. m_ indicates that it is a

member variable for this class. While the control button (Transmit) is a

function performing outputting the data to parallel port. This function need to

be defined by the programmer. This interface is developed for testing purpose.

The source code is attached in Appendix C.

Steps taken to create a simple dialog based Windows by using Visual C++

(MFC).

a. Run Microsoft Visual C++ 6.0

b. On the click File»New. The Tab Windows will appear. Click on

Project. Then select MFC AppWizard(exe). Fill in the project name

under the Project name:. Then, click OK.

c. Select Dialog Based, and then click Finish.

d. The dialog based Windows now has been developed.

The GUI for this project is as shown in Figure 3.6.
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LECTURER

Lecturer [

CLASS SESSION

r sioti

Day;

Time:

CONSULTATION HOURS

f Consuftation Hour 1

Day.

TEST

Time: j

MESSAGE

r

- /

Ext No;

Day:

ion Hour 2

Day:

Venue;

FIGURE 3.6: Graphical User Interface

9. Integrate testing between transmitter and receiver - transmitting a

character, then the receiver should write the character onto memory and

be able to read and display the respective character

The full system is integrated and supposed to perform the routine properly.

The display should be able to display lecturer's name, extension number, class

session, consultation hour and etc. continuously. The receiver also should be

able to handle the interrupt when there is a need to update the information.
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The software should be able to passing data entered by user to the transmitter.

The transmitter should be able to transmit the data according to the defined

protocol.
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3.2 Tool

Tools/equipment required to complete the tasks::

1. PIC16F84 microcontroller & datasheet

2. PIC16F871 microcontroller & datasheet

3. Infra Red LED

4. 16 MHz oscillator

5. 4 MHz oscillator

6. ST24C08 - Serial 8K EEPROM & datasheet

7. LCD Display (5x7 dots) & datasheet

8. 38 kHz infrared filter

9. Transistor (2 X 2N3904 & 2N3906)

10. Oscilloscope

11. Multimeter

12. PICStart/Warpl3

13. MPLab Software

14. Visual C++Software
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CHAPTER 4

RESULTS AND DISCUSSION

This section discusses the debugging process of the system. Firstly, it focuses into the

hardware followed by the software. In the hardware, it focuses on the connection of the

circuit. While in debugging the software, it focuses on the ability of the software to

passing the parameter to the transmitter. Furthermore, it discusses the confirmation

testing of the system by observing the signal generated by the transmitter.

4.1 The hardware

The construction of the hardware has been done. The hardware does not have any short

circuit. The hardware for receiver and transmitter are shown in Figure 4.1 and Figure

4.2 respectively.

£to: r#- •• •

tai*-. ma—mm

\?T'mmWmll'3**1-- '•'V.''17!

Figure 4.1: Receiver Circuit
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Figure 4.2: Transmitter Circuit

4.2 Debugging

For the receiverthere is no problem in connection. However, at the beginning there is a

problem regarding the I2C protocol. Supposed it performs writing a character to the

NVM, read the character and display on the LCD. The problem is no character is

displayed. The problem is discussed in the discussion section.

For the transmitter, the signal generated was observed using oscilloscope. For the

debugging process, the transmitter must be able to generate the signal as shown in

Figure 2.4.
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Comment: From Figure 4.3, it shows that the microcontroller is being able to transmit

Start Pulse, data bit ' V Pulse and data bit '0' Pulse. The dark area is actually is the 38

kHz carrier that is used to transmit the signal. From Figure 4.4, it shows the Start Pulse

of duration 3 .01 mS. This duration is almost as desired Start Pulse where the theory

value is 2.4mS for HIGH state and 0.6mS for LOW state which the sum is 3.00 mS.

From Figure 4.5 and Figure 4.6, it shows the T Pulse and '0' Pulse respectively. The

T Pulse duration is 1.81mS and '0' Pulse duration is 1.21mS. Both durations also are

close to the theory value which are 1.8mS for T Pulse and 1.2mS for '0' Pulse. Thus,

from this waveform it is confirmed that the microcontroller is capable of generating

those three signals and the code is assumed no error.

In debugging the software, the dummy interface was developed. This dummy software

is simple software whereby it passes a character to the transmitter, and then the

transmitter transmits the character. The purpose of this dummy software is to confirm

whether the software is being able to pass the value to the transmitter. Then, the

transmitter on the other hand transmits the character using the defined protocol. Figure

4.7 shows the dummy software.

Ira.ffilliaHl'JftfW

Cancel j

Name: J

Transmit OK

FIGURE 4.7: Dummy Software

In confirmation of the data transmitted by the transmitter, the signal was observed using

oscilloscope. There are three characters were transmitted which are character 'A', 'B',

and 'C. The following figures show the signal captured from the oscilloscope.

31



Stopped

=T;race1= Max 53g.0mV
.jM«H«^..lM.tWT:f^i.i»l..»;tf^<tBg.iW..l

^C

Measure

OFF

Item

Setup
Delay
Setup

=Filter= wOfFsetH

Smoothing : OFF CH1 : 0.000V
BW : FULL CH2 : O.OOV

2004/07/30 13:32:57

2ms/div
(2ms/div]

NORM:5G0kS/s

Freq 12^50kHz Prod 80;00us
-+K<iUam*KUulmmmaHmmwimmmmmmmmmmwmtmmmmH

Time Range

T2

=Record Length:
Main : 10K

Zoom : 500

ALL Scan

EXEC

T1

Cursor

-4.6jjdiv
=Trigger»

Mode : AUTO

Type : EDGE CHI JT
Delay : O.Dns
Hold Off : MINIMUM

Figure 4.8: Character A (ASCII 0x41)
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Figure 4.10: Character C (ASCII 0x43)

Comment: From Figure 4.8, Figure 4.9, and Figure 4.10, it shows that the ASCII for all

the characters was transmitted. The value is the same as the represent in the ASCII table

in Table 4.1. Thus, this confirmed that the coding for transmitting the ASCII for the

character is correct and is assumed to be no error.
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Table 4.1: ASCII Table

Dec HxOct Char Dec HX Oct Html Chr Dec HX Oct Html Chr Dec Hk Oct Html Chr

0 D 000 HUL (null) 32 20 040 £#32 Space 64 40 100 £#64 G 96 60 14Q £#96

1 1 001 SOH (start of heading) 33 21 041 £#33 i 65 41 101 £#65 A 97 61 141 £#97 a

2 2 002 STX (start of text) 34 22 042 &#34 " 66 42 102 &#56 B 98 62 142 £#98 b

3 3 003 ETX (end of text) 35 23 043 £#35 $ 67 43 103 £#67 C 99 63 143 £#99 c

4 4 004 EOT (end of transmission) 36 24 044 £#36 * 68 44 104 £#68 D 100 64 144 &#100; d

5 5 005 EMQ (enquiry) 37 25 045 £#37 % 69 45 105 £#69 E 101 65 145 £#101; e

6 6 006 ACK (acknowledge) 38 26 046 &#3B & 70 46 106 £#70 F 102 66 146 £#102; f

7 7 007 BEL (bell) 39 27 047 &#39 1 71 47 107 £#71 G 103 67 147 £#103; g

e 9 010 BS (backspace) 40 28 050 £#40 ( 72 40 110 £#72 H 1D4 63 150 £#104; h

9 9 Oil TAB (horizontal tab) 41 29 051 £,#41 ) 73 49 111 £#73 I 105 69 151 £#105; i

10 A 012 LF [NL line feed, nera line) 42 2A 052 6#42 •n 74 4A 112 £#74 J 106 6A 152 £#106; 5

11 B 013 VT (vertical tab) 43 2B 053 6|43 + 75 4B 113 £#75 K 107 6B 153 £#107; k

12 C 014 FF (NP form feed, new page) 44 2C 054 s#44 , 76 4C 114 £#76 L 1DB 6C 154 &#108; 1

13 D 015 CR (carriage return) 45 2D 055 s#45 ~ 77 4D 115 £#77 M 1D9 6D 155 £#109; m

14 E 016 SO (shift out) 46 2E 056 s#46 7B 4E 116 £#78 H 110 6E 156 £#110; n

15 F 017 SI (shift in) 47 2F 057 fi#47 / 79 4F 117 £#79 0 111 6F 157 £#111; o

16 ID 020 DLE (data link escape) 48 30 060 s#4B 0 00 50 120 £#60 P 112 70 160 £#112; P

17 11 021 DC1 (device control 1) 49 31 061 s#49 1 81 51 121 £#B1 Q 113 71 161 £#113; q

18 12 022 DC2 (device control 2) 50 32 062 s#50 2 82 52 122 £#82 R 114 72 162 £#114; r

19 13 023 DC3 (device control 3) 51 33 063 £#51 3 83 53 123 £#83 S 115 73 163 s#115; s

2D 14 024 DC4 (device control 4) 52 34 064 £#52 4 B4 54 124 6#64 T 116 74 164 s#116; t

21 15 025 MAK (negative acknowledge) 53 35 065 £#53 5 85 55 125 £#85 U 117 75 165 s#117; u

22 16 026 SYH (synchronous idle) 54 36 066 £#54 6 06 56 126 s#86 V 118 76 166 tfllB; v

23 17 027 ETB (end of trans, block) 55 37 067 £#55 7 87 57 127 s#87 u 119 77 167 6*115; w

24 18 030 CM (cancel) 56 38 070 t#56 a 88 58 130 &#8B X 120 78 170 &#12Q; x

25 19 031 EH (end of medium) 57 39 071 £#57 9 89 59 131 fi#89 Y 121 79 171 £#121; y

26 1A 032 SUB (substitute) 58 3A 072 £#58 90 5A 132 £#90 Z 122 7A 172 £#122; z

27 IB 033 ESC (escape) 59 3B 073 £#59 ; 91 5B 133 £#91 [ 123 7B 173 £#123; {

28 1C 034 FS (file separator) 60 3C 074 £#60 < 92 5C 134 £#92 \ 124 7C 174 £#124; 1

29 ID 035 G5 (group separator) 61 3D 075 £#61 = 93 5D 135 fi#93 ] 125 7D 175 £#125; }

30 IE 036 R5 (record separator) 62 3E 076 £#62 > 94 5E 136 £#94 A
126 7E 176 &#126; »

31 IF 037 US (unit separator) 63 3F 077 £#63 i 95 5F 137 £#95
_

127 7F 177 £#127; DEL

Source: www.asciitable.com

4.3 Discussion

For the receiver, it must be able to sampling, storing and displaying data transmitted. It

must display the data continuously. Some features have been added to the receiver.

There are LED's to indicate power ON, failure in memory and storing data. As users

plug in the power supply, green LED will be ON. This indicates the hardware is

working and the hardware should display all the particulars discussed before. When a

user transmits updated data from a PC, the receiver's routine is interrupted. While

downloading the data it will display a phrase 'Downloading...'. At the same time the

orange LED will be ON and OFF as the block of data is transmitted to indicate the

block is being storing onto memory. Right after downloading process is finish, it will

display a phrase 'Completed'. After that it will continue with its main routine.

For the transmitter, it must be able to generate the infrared signal. It also must be able to

take data from a PC and then transmits to the receiver.
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For the software it must be able to pass the data to the transmitter. It also must generate

the protocol in which the transmitter could understand. It is also play a role in

generating a protocol for infrared transmission. The software does not have to be

installed. Users just need to copy the software onto their PC. However, there are some

files to be copied onto their system. There are MFC24D.DLL, MFC024D.DLL, and

MSVCRTD.DLL. For Windows 98 users, those files should be copied onto

Windows/System directory. For Windows XP users, those files should be copied onto

Windows/System32 directory. However, if their PC has been equipped with Microsoft

Visual C++ software, they may have to skip the procedure.
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CHAPTER 5

CONCLUSION AND RECOMMENDATION

5.1 Conclusion

The Information Display Console (IDC) may convey a message to the others such as

lecturer's name, extension number, class session, consultation hour, test to be

conducted, as well as away message. With the IDC it can improve the communication

among lecturers and students. It also helps other, at least know the lecturer's schedule.

It also helps to reduce the paper usage and can be a substitute especially in putting on a

message.

5.2 Recommendation

The IDC should be installed to enhance the communication among others. However, the

IDC s till c an b e i mproved b y adding some modification especially to its appearance.

Both the transmitter and receiver circuits can be compacted by using surface mounted

components with well designed printed circuit board. This is to reduce the size of the

hardware. Furthermore, the hardware itself could be equipped with proper housing to

give a nice finishing.

Secondly, further study should be conducted on the receiver about an alternative power

supply in case of black-out. In this case, one might consider the battery-powered as the

alternative. Thus, it must take into account the power consumption, switching

mechanism, and for how long the system can stand in determining and designing the

new battery-powered system.
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APPENDIX A



Receiver Code

Programmer; Ahmad Rizalbin MuhammadArif
ID No: 1922

Program: Electrical& Electronics Engineering
Company: Universiti Teknologi PETRONAS

Note; This code is the receiver code. The routine is performing sampling data transmitted, storing and displaying
character

#include<p!6f871.inc>

cblock

ERRORLEVEL 0,-302 ;suppress bank selection messages
_config _LVP_OFF & _XT_OSC &_WDT_ON &J>WRTE_ON &_CP_OFF &_BODEN_OFF & _DEBUG_OFF

Reserving register

0x20

LoX

Bit_Cntr
Blk_Type
Blk_No
Byte_No
Data_ByteO
Data_Bytel
Data_Byte2
Data_Byte3
Flags
Flags2
Flags 3
Flags4
FlagsR
FlagsS
Imp

tmpl
tmp2
tmp3
tmp4

Byte_NoLect
Byte_NoExt

Byte_NoSlotl
Byte_NoCourse 1
Byte_NoDayl
ByteJ-ioTimel
Byte_NoVenuel

Byte_NoSlot2
Byte_NoCourse2
Byte_NoDay2
Byte_NoTime2
Byte_NoVenue2

Byte_NoConstl
Byte_NoDay3
Byte_NoTime3

Byte_NoConst2

start of general purpose registers

temporary storage
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Byte NoDay4 ;
Byte_NoTime4 ;

Byte_NoTest ;
Byte_NoCourse5 ;
Byte_NoDay5 ;
Byte_NoDate ;
Byte__NoTime5 ;
Byte_NoVenue5 ;

Byte_NoAwyMsg ;

byte ;
i2c_freq ;
nbit ;
w_temp ;
w_temp2 ;
w__temp3 ;
waitLCD ;
W TEMP ;

STATUS_TEMP ;
tmp5
PCLATHJEMP

endc

IR PORT Equ PORTA
TRJSD Equ 0x88

#defme IR In 3

#define RS 7

#define ENABLE 6

#define RW 5

#defme LCD CLR DISPLAY 0x01 0000 0001

#defme LCD CURSOR HOME 0x02 0000 0010

#define LCD ENTRY MODE_SET 0x06 0000 0110

#define LCD CURSOR 0x10 0001 0000

#define LCD FUNCTION SET 0x38 0011 1000

#define LCD INIT CGRAM 0x40 0100 0000

#define LCD FNIT DDRAM 0x80 1000 0000

#define LCD INIT OxOC 0000 1101

#define WAITLCD 0x05 0000 0101

#define EirFlag 0 Flags used f
#define StartFlag 1

#define One 2

#define Zero 3

#define StopFlag 4

#define Update 0

#define Lect Blk 0x00

#define Ext_Blk 0x01

#define Slotl_Blk 0x02

#define Course! Blk 0x03

#define Dayl Blk 0x04

#defme Timel Blk 0x05

#define Venue l_Blk 0x06

#define Slot2_Blk 0x07

#define Course2 Blk 0x08

#define Day2 Blk 0x09

#define Time2_Blk OxOA

#defme Venue2_Blk OxOB

#defme Constl Blk OxOC

#define Day3_Blk OxOD
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#define Time3 Blk OxOE

#define

#define

#define

Const2__Blk
Day4_Blk
Time4_Blk

OxOF

0x10

0x11

#define

#defme

#define

#defme

#define

#define

Test_Blk
Course5 Blk

Day5_B1k
Date Blk

Time5 Blk

Venue5_Blk

0x12

0x13

0x14

0x15

0x16

0x17

#define

#define

AwyMsg_Blk
Stop_Blk

0x18

OxAA

#defme

#define

LectFlag
ExtFlag

0

1

;Flags used to determine

#define

#define

#define

#define

#define

Slot 1Flag
Course 1Flag
Day1Flag
TimelFlag
Venue 1Flag

2

3

4

5

6

#define

#define

#define

^define

#define

Slot2Flag
Course2Flag
Day2Flag
Time2Flag
Venue2Flag

7

0

1

2

3

#define

#defme

#define

Const1Flag
Day3Flag
Time 3Flag

0

1

2

#define

#define

#defme

Con st2 Flag
Day4Flag
Time4Flag

3

4

5

#define

#define

#define

#define

#define

#define

TestFlag
Course5Flag
Day5Flag
DateFlag
TimeSFlag
Venue5Flag

0

1

2

3

4

5

#defme

#define

AwyMsgFlag
Stop_Flag

6

7

#define

#define

#define

#define

#define

#define

^define

WREG

I2C PORT

SDA IN

HIGH HIGH

HIGH LOW

LOW LOW

LOW_HIGH

0

PORTA

2

0x03

0x02

0x00

0x01

0000 0011

0000 0010

0000 0000

0000 0001

org 0x00
goto Setup

org 0x04
goto ISR
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ISR

Push nop

nop

MOVWF W TEMP

SWAPF STATUS,W
CLRF STATUS

MOVWF STATUS TEMP

MOVF PC LATH, W

MOVWF PCLATH TEMP

CLRF PCLATH

Clrf FlagsR
call delay4
call ISR Code

Copy W to TEMP register
Swap status to be saved into W
bank 0, regardless of current bank, Clears IRP.RP1,RP0
Save status to bank zero STATUS_TEMP register
Only required if using pages 1, 2 and/or 3
Save PCLATH into W

Page zero, regardless of current page

-Interrupt Service Routine End-

Setup

Setup Microcontroller •
org OxDO

BCF STATUS, RPO
BCF STATUS, RP1
CLRF PORTA

BSF STATUS, RPO
MOVLW 0x06

MOVWF ADCON1

MOVLW OxOC

MOVWF TRISA

movlw 0x90

movwf INTCON

bcf OPTION„REG, 6
bcf INTCON, 1

movlw

movwf

clrf

clrf

bcf

call

clrf

clrf

bsf

bsf

clrf

clrf

clrf

clrf

clrf

clrf

clrf

clrf

clrf

clrf

clrf

goto

0x01

TRISB

TRISC

TRiSD

STATUS, RPO
InitLCD

PORTA

PORTB

PORTC, 0
PORTC, 3
PORTD

Data_Byte0
Data_Bytel
Data_Byte2
Data_Byte3
tmpl
Flags
Flags2
Flags3
Flags4
Flags5
main

End

Start of Setup routine

BankO

Initialize PORTA by clearing output data latches
Select Bank 1

Configure all pins
as digital inputs
Value used to initialize data direction

Set RA<3:0>as inputs RA<5:4>as outputs TR1SA<7:6> are always
read as '0'.

Value to enable Global and External Interrupt
Enable Global Interrupt and External Interrupt
Enable Edge Trigger for External Interrupt

; Value used to initialize data direction
; Set Port B<7:1> as an output and PortB<0> as an input
; Set Port C as an output
; Set Port D as an output

Select Bank 0

LCD Initialization

Clearing Content of PORTA
Clearing Content of PORTB

Clearing Content of PORTD
Clearing Content of Data^ByteO Register
Clearing Content of Data_Bytel Register
Clearing Content of Data_Byte2 Register
Clearing Content of Data_Byte3 Register
Clearing tmpl Register
Clearing Flags Register
Clearing Flags2 Register
Clearing Flags3 Register
Clearing Flags4 Register
Clearing Flags5 Register
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org

— Mam Routine

0x100

main clrwdt Clearing watchdog timer to avoid internal reset
btfsc FlagsR, LectFlag Check Lecturer Name Flag. Display if Set
call RLect Display Lecturer Name
btfsc FlagsR, ExtFlag Check Ext. No Flag. Display if Set
call RExt Display Ext. No.
btfsc FlagsR, SlotlFlag Check Slot 1 Flag. Display if Set
call RSIotl Display Slot 1 (Class Session)
btfsc FlagsR, Slot2Flag Check Slot 2 Flag. Display if Set
call RSlot2 Display Slot 2 (Class Session)
btfsc FlagsR, 4 Check Consultation Hour 1 Flag. Display if Set
call RConstl Display Consultation Hour 1
btfsc FlagsR, Const2Flag Check Consultation Hour 2 Flag. Display if Set
call RConst2 Display Consultation Hour 2
btfsc FlagsR, 5 Check Test Flag. Display if Set
call RTest Display Test.
btfsc FlagsR, AwyMsgFlag Check Away Message Flag. Display if Set
call RAwyMsg Display Away Message
goto main Go to Main

Inte„__ Tupt Service Routine Function
ISR_Code

movlw 0x01 Value used to Clear Display
call InstLCD , Clearing: display
movlw 0x83 Value used determine location at display
call InstLCD Location it display
movlw 'D'

call DataLCD

movlw 'o'

call DataLCD Displaying
movlw W

call DataLCD Downloading....
movlw

call DataLCD

movlw T This is to indicate the beginning of sampling and storing process
call DataLCD

movlw 'o'

call DataLCD

movlw 'a'

call DataLCD

movlw 'd'

call DataLCD

movlw V

call DataLCD

movlw y

call DataLCD

movlw 'g'
call DataLCD

movlw '.'

call DataLCD

movlw V

call DataLCD

movlw 7

call DataLCD

movlw ','

call DataLCD

movlw OxCO

call InstLCD

dash movlw 0x14

movwf tmp

_dash cli-wdt
movlw '-'

call DataLCD

decfsz tmp, f
goto _dash
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goto update
update call GtStBlk

btfsc Flags2, LectFlag
goto WLect
btfsc Flags2, ExtFlag
goto WExt
btfsc Flags2,SlotlFlag
goto WSlotl
btfsc Flags2, CourselFlag
goto WCourse I
btfsc Flags2, DaylFlag
goto WDayl
btfsc Flags2, TimelFlag
goto WTimel
btfsc Flags2, VenuelFlag
goto WVenuel
btfsc Flags2, Slot2Flag
goto WSlot2
btfsc Flags3, Course2Flag
goto WCourse2
btfsc Flags3, Day2Flag
goto WDay2
btfsc Flags3, Time2Flag
goto WTime2
btfsc Flags3, Venue2Flag
!goto WVenue2
btfsc Flags4, ConstlFlag
goto WConstl
btfsc Flags4, Day3Flag
goto WDay3
btfsc Flags4, Time3Flag
goto WTime3
btfsc Flags4, Const2Flag
goto WConst2
btfsc Flags4, Day4Flag
goto WDay4
btfsc Flags4, Time4Flag
goto WTime4
btfsc Flags5, TestFlag
goto WTest
btfsc Flags5, Course5Flag
goto WCourseS
btfsc Flags5, DaySFlag
goto WDay5
btfsc Flags5, DateFlag
goto WDate
btfsc Flags5, Time5Flag
goto WTime5
btfsc Flags5, Venue5Flag
goto WVenue5
btfsc Flags5, AwyMsgFlag
goto WAwyMsg
btfss Flags4, Stop_Flag

ISR

goto
goto

movlw

call

movlw

call

movlw

call

movlw

call

movlw

call

movlw

call

movlw

update
ISR

0x01

InstLCD

0x80

InstLCD

DataLCD

DataLCD

DataLCD

DataLCD

(Updating Information)
Get Start Block

Check if Lecturer Block is Sent Write/Store if Flag is Set
Write/Store the Data

Check if Ext No Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if Slot 1 Block is Sent. Write/Store if Flag is Set
Write/Store the Data
Check if the Course 1 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Day 1 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Time 1 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Venue 1 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Slot 2 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Course 2 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Day2 Block is Sent. Write/Storeif Flag is Set
Write/StoTe the Data

Check if the Time 2 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Venue 2 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Consultation Hour 1 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Day 3 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Time 3 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Consultation Hour 2 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Day 4 is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Time 4 is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Test Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Course 5 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Day 5 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Date Blcok is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Time 5 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Venue 5 Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Away Message Block is Sent. Write/Store if Flag is Set
Write/Store the Data

Check if the Stop Block is Sent. Stop Sampling Data if Flag is Set.

Displaying a phrase

Completed -

This is to indicate that sampling and storing data has been completed
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call DataLCD

movlw •c

call DataLCD

movlw 'o' ,
call DataLCD

movlw 'm'

call DataLCD

movlw V

call DataLCD

movlw V

call DataLCD

movlw 'e'

call DataLCD

movlw T

call DataLCD

movlw 'e'

call DataLCD

movlw 'd'

call DataLCD

movlw "

call DataLCD

movlw '.'

call DataLCD

movlw '.'

call DataLCD

movlw '.'

call DataLCD

movlw v

call DataLCD

movlw '-'

call DataLCD

call delay3

nop

nop

MOVF PCLATH TEMP,W Restore PCLATH

MOVWF PCLATH Move W into PCLATH

SWAPF STATUS_TEMP,W Swap STATUS_TEMP registe
(sets bank to original state)

MOVWF STATUS Move W into STATUS registe
SWAPF W TEMP,F Swap W TEMP
SWAPF W_TEMP,W Swap W_TEMP into W

bcf INTCON, 1 Enabling Next Interrupt
nop

retfie Return from Interrupt Routine
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RLect movlw

au aiiu uo[jlaying an i a

0x01

call InstLCD

movlw 0x80 Display at 1st line
call InstLCD

call ReadL Read String 'Lecturer: '
movlw 0x8A

call InstLCD

movlw 0x10

movwf w_temp3
movf Byte_NoLect, w
movwf Byte_No
call ReadG

call delay2
return

RExt movlw OxCO 2nd Line

call InstLCD

call ReadE Display String 'Ext No;'
call delay3
return

RSlotl movlw 0x01

call InstLCD

call ReadC

movlw OxCO

call InstLCD

movlw 0x40

movwf w_temp3
movf Byte_NoSlotl, w
movwf Byte No
call ReadG

call delay2
call RCourse 1

call delay3
call RDayl
call delay3
call RTimel

call delay3
call RVenue 1

call delay3
return

RCourse movlw 0xC8

call InstLCD

movlw 0x47

movwf w_temp3
movf Byte_NoCoursel, w
movwf Byte No
call ReadG

call delay2
return

RDayl movlw 0xC8

call InstLCD

call ClearLCD

movlw 0xC8

call InstLCD

movlw 0x50

movwf w_temp3
movf Byte_NoDayl, w
movwf Byte No
call ReadG

call delay2
return

RTimel movlw 0xC8

call InstLCD

call ClearLCD
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movlw OxC8

call InstLCD

movlw 0x54

movwf w_temp3
movf Byte_NoTimel, w
movwf Byte_No
call ReadG

call delay2
return

RVenuel movlw OxC8

call InstLCD

call ClearLCD

movlw OxC8

call InstLCD

movlw 0x60

movwf w_temp3
movf Byte_NoVenuel, w
movwf Byte No
call ReadG

call delay2
return

RSlot2 movlw 0x01

call InstLCD

call ReadC

movlw OxCO

call InstLCD

call ClearLCD

movlw OxCO

call InstLCD

movlw 0x70

movwf w_temp3
movf Byte_NoSlot2, w
movwf Byte_No
call ReadG

call delay2
call RCourse2

call delay3
call RDay2
call delay3
call RTime2

call delay3
call RVenue2

call delay3
return

RCourse2 movlw 0xC8

call InstLCD

movlw 0x77

movwf w_temp3
movf Byte_NoCourse2, w
movwf Byte No
call ReadG

call delay2
return

RDay2 movlw 0xC8

call InstLCD

call ClearLCD

movlw OxCS

call InstLCD

movlw 0x80

movwf w_temp3
movf Byte_NoDay2, w
movwf Byte_No
call ReadG

call delay2
return
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RTime2 movlw 0xC8

call InstLCD

call ClearLCD

movlw 0xC8

call InstLCD

movlw 0x84

movwf w_temp3
movf Byte_NoTime2, w
movwf Byte_No
call ReadG

call delay2
return

RVenue2 movlw 0xC8

call InstLCD

call ClearLCD

movlw OxC8

call InstLCD

movlw 0x90

movwf w_temp3
movf Byte_NoVenue2, w
movwf Byte No
call ReadG

call delay2
return

RConstl movlw 0x01

call InstLCD

movlw 0x80

call InstLCD

movlw OxAO

movwf w_temp3
movf Byte_NoConstl, w
movwf Byte No
call ReadG

call delay2
call RDay3
call RTime3

call delay3
return

RDay3 movlw OxCO

call InstLCD

movlw OxBO

movwf w_temp3
movf Byte_NoDay3, w
movwf Byte No
call ReadG

call delay2
return

RTime3 movlw 0xC4

call InstLCD

movlw 0xB4

movwf w_temp3
movf Byte_NoTime3, w
movwf Byte_No
call ReadG

call delay2
return

RConst2 movlw 0x01

call InstLCD

movlw 0x80

call InstLCD

movlw OxAO

movwf w_temp3
movf Byte_NoConst2, w
movwf Byte_No
call ReadG
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call delay2
call RDay4
call RTime4

call delay3
return

RDay4 movlw OxCO

call InstLCD

movlw OxCO

movwf w_temp3
movf Byte_NoDay4, w
movwf Byte No
call ReadG

call delay2
return

RTime4 movlw 0xC4

call InstLCD

movlw 0xC4

movwf w_temp3
movf Byte_NoTime4, w
movwf Byte_No
call ReadG

call delay2
return

RTest movlw 0x01

call InstLCD

movlw 0x00

movwf w_temp3
movf Byte_NoTest, w

movwf Byte_No
call Readg
call delay2
call RCourse5

call delay3
call RDay5
call RDate

call delay3
call RTime5

call delay3
call RVenue5

call delay3
return

RCourse5 movlw OxCO

call InstLCD

movlw 0x05

movwf w_temp3
movf Byte_NoCourse5, w
movwf Byte_No
call Readg
call delay2
return

RDay5 movlw OxCO

call InstLCD

call ClearLCD

movlw OxCO

call InstLCD

movlw 0x10

movwf w_temp3
movf Byte_NoCourse5, w
movwf Byte_No
call Readg
call delay2
return

RDate movlw 0xC4

call InstLCD
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movlw 0x14

movwf w_temp3
movf Byte_NoDate, w
movwf Byte_No
call Readg
call delay2
return

RTime5 movlw OxCO

call InstLCD

call ClearLCD

movlw OxCO

call InstLCD

movlw 0x20

movwf w_temp3
movf Byte_NoTime5, w
movwf Byte_No
call Readg
call delay2
return

RVenue5 movlw OxCO

call InstLCD

call ClearLCD

movlw OxCO

call InstLCD

movlw 0x30

movwf w_temp3
movf Byte__NoVenue5, w
movwf Byte_No
call Readg
call delay2
return

RAwyMsg movlw 0x01

call InstLCD

movlw 0x07

call InstLCD

movlw 0x94

call InstLCD

movlw 0x40

movwf w_temp3
movf Byte_NoAwyMsg, w
movwf Byte_No
call Readg
call delay2
return

•End'

Get Start Block Signal and Check the Parameter •

GtStBlk call

call

call

ReadIR

Get_DataO
delay2

call

call

call

ReadIR

Get^DataO
delay2

call

call

call

ReadIR

Get_Datal
delay2

call

call

call

ReadIR

Get_Data2
delay2

movf

movwf

movf

Data ByteO, w
Blk_Type
Data_Bytel, w

Check for the Infra red signal

Storing all Data in Start Block
(Type of Block, # of Block, # of Byte)

49



Chk Blk

movwf

movf

movwf

goto

clrf

clrf

clrf

clrf

Try_LectBlk

Try_ExtBlk

Try_SlotlBlk

Try_CourselBlk

Try_DaylBlk

Try_TimelBlk

TryJVenuelBlk

Blk_No
Data_Byte2, w
Byte_No
Chk_Blk

Flags2
Flags3
Flags4
Flags5

; Check Block that has been Transmitted

; Clearing Flags

movf

sublw

btfss

goto
movf

movwf

bsf

bsf

Tetlw

movf

sublw

btfss

goto

movf

movwf

bsf

bsf

retlw

movf

sublw

btfss

goto
movf

movwf

bsf

bsf

retlw

movf

sublw

btfss

goto

movf

movwf

bsf

retlw

movf

sublw

btfss

goto
movf

movwf

bsf

retlw

movf

sublw

btfss

goto
movf

movwf

bsf

retlw

movf

sublw

btfss

Blk_Type, w
Lect_Blk
STATUS, Z
Try_ExtBlk
Byte_No, w
Byte_NoLect
Flags2, LectFlag
FlagsR, LectFlag
0x00

BIk_Type, w
Ext_Blk
STATUS, Z
Try_SlotlBlk
Byte_No, w
Byte_NoExt
Flags2, ExtFlag
FlagsR, ExtFlag
0x00

Blk_Type, w
Slotl_Blk
STATUS, Z
Try_Course 1Blk
Byte_No, w
Byte_NoSlotl
Flags2,SlotIFlag
FlagsR, Slotl Flag
0x00

Blk_Type, w
Course l_Blk
STATUS, Z
Try_DaylBlk
Byte_No, w
Byte_NoCourse 1
Flags2, Course 1Flag
0x00

Blk_Type, w
Dayl_Blk
STATUS, Z
Try_TimelBlk
Byte_No, w
Byte_NoDayl
Flags2, DaylFlag
0x00

Blk_Type, w
Timel_Blk
STATUS, Z

Try_VenuelBlk
Byte_No, w
Byte__NoTimel
Flags2,TimelFlag
0x00

Blk_Type, w
Venue l_Blk
STATUS, Z

the algorithm for checking the Block Type is as follow

From the start block, the block type byte is stored to a temporary register.
Then this value is subtract to the assigned value of type of block.
If the remainder is zero. Thus, the respective block s correct.
Thus, certain flag is set according to the type of block
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goto Try_Slot2Blk
movf Byte_No, w
movwf Byte_NoVenue 1
bsf Flags2, VenuelFlag
retlw 0x00

Try_Slot2Blk movf Blk Type, w
sublw Slot2 Blk

btfss STATUS, Z
goto Try_Course2Blk
movf Byte No, w
movwf Byte NoSlot2
bsf Flags2, Slot2Flag
bsf FlagsR, Slot2Flag
retlw 0x00

Try_Course2Blk movf Blk_Type, w -,
sublw Course2 Blk

btfss STATUS, Z
goto Try_Day2Blk
movf Byte_No, w
movwf Byte_NoCourse2 ,
bsf Flags3, Course2Flag ;
retlw 0x00

Try_Day2Blk movf Blk Type, w
sublw Day2 Blk ;
btfss STATUS, Z ;
goto Try_Time2Blk ;
movf Byte_No, w ;
movwf Byte_NoDay2 ;
bsf Flags3, Day2Flag ;
retlw 0x00 ;

Try_Time2Blk movf Blk_Type, w ;
sublw Time2 Blk ;
btfss STATUS, Z ;
goto Try_Venue2Blk ;
movf Byte_No, w ;
movwf Byte_NoTime2 ;
bsf Flags3,Time2Flag ;
retlw 0x00 ;

Try_Venue2Blk movf Blk_Type, w ;
sublw Venue2 Blk ;
btfss STATUS, Z ;
goto Try_ConstlBlk ;
movf Byte_No, w ;
movwf Byte_NoVenue2 ;
bsf Flags3, Venue2Flag ;
retlw 0x00 ;

Try_ConstlBlk movf Blk Type, w ;
sublw Constl Blk ;
btfss STATUS, Z ;
goto Try_Day3Blk ;
movf Byte_No, w ;
movwf Byte_NoConstl ;
bsf Flags4, ConstlFlag ;
bsf FlagsR, 4 ;
retlw 0x00 ;

Try_Day3Blk movf Blk Type, w ;
sublw Day3 Blk ;
btfss STATUS, Z ;
goto Try_Time3Blk ;
movf Byte_No, w ;
movwf Byte_NoDay3 ;
bsf Flags4, Day3Flag ;
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retlw 0x00

Try_Time3Blk movf Blk_Type, w
sublw Time3 Blk

btfss STATUS, Z
goto Try_Const2Blk
movf Byte_No, w
movwf Byte_NoTime3
bsf Flags4, Time3Flag
retlw 0x00

Try_Const2Blk movf BlkJType, w
sublw Const2 Blk

btfss STATUS, Z
goto Try_Day4Blk
movf Byte_No, w
movwf Byte_NoConst2
bsf Flags4, Const2Flag
bsf FlagsR, Const2Flag
retlw 0x00

Try_Day4Blk movf Blk Type, w
sublw Day4 Blk
btfss STATUS, Z
goto Try_Time4Blk
movf Byte_No, w
movwf Byte_NoDay4
bsf Flags4, Day4Flag
retlw 0x00

Try_Time4Blk movf Blk_Type, w
sublw Time4 Blk

btfss STATUS, Z
goto Try_TestBlk
movf Byte_No, w
movwf Byte_NoTime4
bsf Flags4, Time4Flag
retlw 0x00

Try_TestBlk movf Blk Type, w
sublw Test Blk

btfss STATUS, Z
goto Try_Course5Blk
movf Byte_No, w
movwf Byte_NoTest
bsf Flags5, TestFlag
bsf FlagsR, 5
retlw 0x00

Try_Course5Blk movf BlkJType, w
sublw Course5 Blk

btfss STATUS, Z
goto Try_Day5Blk
movf Byte_No, w
movwf Byte_NoCourse5
bsf Flags5, Course5Flag
retlw 0x00

Try_Day5Blk movf Blk Type, w
sublw Day5 Blk
btfss STATUS, Z
goto Try_DateBlk
movf Byte_No, w
movwf Byte_NoDay5
bsf Flags5, Day5Flag
retlw 0x00

Try_DateBlk movf Blk_Type, w
sublw Date Blk

btfss STATUS, Z
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goto Try__Time5Blk
movf Byte_No, w
movwf Byte_NoDate
bsf Flags5, DateFlag
retlw 0x00

TryJTime5Blk movf Blk_Type, w
sublw Time5 Blk

btfss STATUS, Z

goto Try_Venue5Blk
movf Byte_No, w
movwl Byte_NoTime5
bsf Flags5, Time5Flag
retlw 0x00

Try_Venue5Blk movf Blk Type, w
sublw Venue5 Blk

btfss STATUS, Z

goto Try_AwyMsgBlk
movf Byte_No, w
movwl Byte_NoVenue5
bsf FlagsS, Venue5Flag
retlw 0x00

Try_AwyMsgBlk movf Blk_Type, w
sublw AwyMsg Blk
btfss STATUS, Z

goto Try_StopBlk
movf Byte_No, w
movw: Byte_NoAwyMsg
bsf Flags5, AwyMsgFlag
bsf FlagsR, AwyMsgFlag
retlw 0x00

Try_StopBlk movf Blk Type, w
sublw Stop Blk
btfss STATUS, Z

goto Try_Error
movf Byte_No, w
sublw Stop Blk
btfss STATUS, Z
goto Try_Error
bsf -lags4, Stop Flag
retlw 0x00

Try_Error nop
goto SR2

return

— Inn (

ReadIR

ReadIR clrwdt
clrf Flags
call Read_ 3ulse ;wait for start pulse (2.4mS)
btfss Flags, StartFlag
goto ReadIR

return

Get_DataO movlw 0x08 ;set up to read 7 bits
movwf Bit Cntr

clrf Data_Byte0
Next__RcvBitO clrwdt

call Read_Pulse
btfsc Flags,StartFlag ; abort if another Start bit
goto ReadIR

btfsc Flags.ErrFlag ; abort if error

goto ReadIR

rlf Data_Byte0, f
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bcf Data_Byte0, 0
btfss Flags, Zero
bsf Data^ByteO, 0
decfsz Bit_Cntr, f
goto Next_RcvBitO
return

Get_Datal movlw 0x08

movwf Bit_Cnfr
clrf DataJ3ytel

Next_RcvBitl clrwdt

call Read_Pulse
btfsc Flags,StartFlag
goto ReadIR

btfsc Flags,ErrFlag
goto ReadIR

rlf Data_Bytel,f
bcf Data_Bytel,0
btfss Flags, Zero
bsf Data Byte 1,0
decfsz Bit„Cntr, f
goto NextJtcvBitl
return

Get_Data2 movlw 0x08

movwf Bit_Cntr
clrf DataJ3yte2

Next_RcvBit2 clrwdt

call ReadPulse

btfsc Flags,StartFlag
goto ReadIR

btfsc Flags, ErrFlag
goto ReadIR

rlf Data_Byte2, f
bcf Data_Byte2, 0
btfss Flags, Zero
bsf Data_Byte2, 0
decfsz Bit_Cntr, f
goto Next_RcvBit2
return

Get_Data3 movlw 0x08

movwf Bit_Cntr
clrf Data_Byte3

Next_RcvBit3 clrwdt

call Read_Pulse
btfsc Flags, StartFlag
goto ReadIR

btfsc Flags,ErrFlag
goto ReadIR

rlf Data Byte3, f
bcf Data_Byte3, 0
btfss Flags, Zero
bsf Data Byte3, 0
decfsz Bit_Cntr, f
goto Next__RcvBit3
return

Rn^ nfD^lD

;wait for start pulse (2.4mS)return

;set up to read 7 bits

;abort if another Start bit

:abort if error

;wait for start pulse (2.4mS)return

;set up to read 7 bits

;abort if another Start bit

:abort if error

;wait for start pulse (2.4mS)return

;set up to read 7 bits

;abort if another Start bit

;abort if error

;wait for start pulse (2.4mS)return

Read pulse width, return flag for StartFlag, One, Zero, or ErrFlag
output from IR receiver is normally high, and goes low when signal received

Read Pulse clrf LoX

Still_High clrwdt
btfss

goto

IR_PORT, IRJn
Next

;and wait until goes low
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Next

goto Still_High

clrwdt

call delay
incf LoX,f
btfss IR PORT, IR In
goto Next

goto Chk Pulse

; test if Zero, One, or Start (or error)

Chk_Pulseclrf Flags

;waste time to scale pulse
;width to 8 bits

;loop until input high again

TryError movf LoX,w ; check if pulse too small
addlw d'255'-d'60' ;ifLoX<=20
btfsc STATUS, C

goto TryZero
bsf Flags, ErrFlag ; Error found, set flag
retlw 0x00

Try Zero movf LoX, w ; check if zero
addlw d'255'-d'80' ;ifLoX<=60
btfsc STATUS, C
goto TryOne
bsf Flags, Zero ; Zero found, set flag
retlw 0x00

TryOne movf LoX, w ;check ifone
addlw d'255'-d'130' ;ifLoX<=112
btfsc STATUS, C
goto TryStop
bsf Flags, One ; One found, set flag
retlw 0x00

TryStop movf LoX, w ; check if start
addlw d'255'-d'190' ;ifLoX<=180
btfsc STATUS, C
goto TryStart
bsf Flags, StopFlag ; Start pulse found
retlw 0x00

TryStart movf LoX, w ; check if start
addlw d'255'-d'250' ;ifLoX<=180
btfsc STATUS, C
goto NoMatch

bsf Flags, StartFlag ; Stop pulse found
retlw 0x00

NoMatch ; pulse too long
bsf Flags, ErrFlag ; Error found, set flag
retlw 0x00

; •—end of pulse measurir ig routines

InitLCn

InitLCD clrwdt

movlw LCD INIT DDRAM

call InstLCD

movlw LCD_INIT_CGRAM
call InstLCD

movlw LCD FUNCTION SET

call InstLCD

movlw LCD CURSOR

call InstLCD

movlw LCD_INIT
call InstLCD

movlw LCD_ENTRYJV10DE_S ET
call InstLCD

movlw LCD CURSOR HOME
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InstLCD

call InstLCD

movlw LCD_CLR_DISPLAY
call InstLCD

return

—end InitLCD

InstLCD

clrwdt

clrf

bcf

bcf

bcf

movwf

bsf

call

bcf

call

call

call

return

end-

PORTD

PORTB, RS
PORTB, RW
PORTB, ENABLE
PORTD

PORTB, ENABLE
WaitLCD

PORTB, ENABLE
WaitLCD

WaitLCD

WaitLCD

-DataLCD- -LCD

DataLCD

clrwdt

bsf

bcf

bcf

movwf

nop

bsf

call

bcf

retlw

PORTB, RS
PORTB, RW
PORTB, ENABLE
PORTD

PORTB, ENABLE
WaitLCD

PORTB, ENABLE
0x00

data for LCD

—-end-

ClearLCD

ClearLCD

-LCD

movlw 0x14

movwf tmp

clrwdt

movlw 0x20

call DataLCD

call delay2
decfsz tmp,f
goto ClearLCD

return

; WaitLCD

WaitLCD clrwdt

movlw WAITLCD

movwf waitLCD

_WaitLC call Wait
decfsz waitLCD, 1
goto _WaitLC
return

• end WaitLCD

-LCD

Wait

Wait

decrement waitLCD, skip if zero

RETURN

LCD

-Wait GLOBAL

clrwdt

movlw

movwf

clrwdt

decfsz

goto

OxFF

wtemp

w_temp, 1
Wait

1 cycle
1(2) cycle
2 cycle
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return RETURN

wait

-, .—"-C11 u

clrwdt

movlw OxFF

movwf w_temp2
_wait clrwdt

call Wait

decfsz w_temp2,l
goto _wait
return

• i r-n T7T rwr'Tirwc cwn

delay movlw 0x08 Delay lOuS
movwf tmpl
nop

nop

nop

delay nop

decfsz tmpl,f
goto -delay
return

delay2 movlw OxFF Delay 20mS
movwf tmp2

_delay2 clrwdt

call delay
call delay
call delay
call delay
call delay
call delay
call delay
call delay
decfsz tmp2, f
goto _delay2
return

delay3 movlw 0x32 Delay Is
movwf tmp3

_delay3 clrwdt

call delay2
decfsz tmp3, 1
goto _delay3
return

delay4 movlw 0x06 Delay 125mS
movwf tmp4

_delay4 clrwdt

call delay2
decfsz tmp4,1
goto _delay4
return

WLect

WExt

NVM Functions Starts

movlw 0x10 Value for Memory Location
movwf w temp3
call WriteNVMG Write at the location

goto update

movlw 0x29 Value for Memory Location
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movwf w temp3
call WriteNVMG

goto update

WSlotl movlw 0x40

movwf w temp3
call WriteNVMG

goto update

WCoursel movlw 0x47

movwf w temp3
call WriteNVMG

goto update

WDayl movlw 0x50

movwf w temp3
call WriteNVMG

goto update

WTimel movlw 0x54

movwf w temp3
call WriteNVMG

goto update

WVenue movlw 0x60

movwf w temp3
call WriteNVMG

goto update

WSlot2 movlw 0x70

movwf w temp3
call WriteNVMG

goto update

WCourse2 movlw 0x77

movwf w temp3
call WriteNVMG

goto update

WDay2 movlw 0x80

movwf w temp3
call WriteNVMG

goto update

WTime2 movlw 0x84

movwf w temp3
call WriteNVMG

goto update

WVenue2 movlw 0x90

movwf w temp3
call WriteNVMG

goto update

WConstl movlw OxAO

movwf w temp3
call WriteNVMG

goto update

WDay3 movlw OxBO

movwf w temp3
call WriteNVMG

goto update

WTime3 movlw 0xB4

movwf w temp3
call WriteNVMG

goto update

Write at the location

In storing data onto memory, it goes the same pattern
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WConsf2 movlw OxAO
movwf w_temp3
call WriteNVMG

goto update

WDay4

WTime4

movlw OxCO

movwf w_temp3
call WriteNVMG

goto update

movlw 0xC4

movwf w_temp3
call WriteNVMG

goto update

WTest movlw

movwf

call

goto

WCourse5 movlw

movwf

call

goto

WDay5 movlw
movwf

call

goto

WDate movlw

movwf

call

goto

0x00

w_temp3
WriteNVMg
update

0x05

w_temp3
WriteNVMg
update

0x10

w_temp3
WriteNVMg
update

0x14

w_temp3
WriteNVMg
update

WTime5 movlw 0x20

movwf w_temp3
call WriteNVMg
goto update

WVenue5 m ovlw

movwf

call

goto

WAwyMsg

0x30

w_temp3
WriteNVMg
update

movlw 0x40
movwf w_temp3
call WriteNVMg
goto update

-WriteData (Page 1)-
WriteNVMG

bcf

Wr

Wr

call

call

movlw

movwf

call

call

movf

movwf

call

call

movf

movwf

clrwdt

call

call

decfsz

goto

PORTC, 3

WaitI2C

StartP

OxAO

byte
OutByte
GetAckP

w_temp3, WREG
byte
OutByte
GetAckP

Blk^No, w
tmp

GtDtBlk

StData

tmp, 1
Wr

xxxx xxxW

Send Slave add
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call StopP
bsf PORTC, 3

return
.

end

•_ U/ri

WriteNVMg
bcf PORTC, 3
call WaitI2C

call StartP

movlw 0xA2

movwf byte
call OutByte
call GetAckP

movf w_temp3, WREG
movwf byte
call OutByte
call GetAckP

wr movf Blk_No, w
movwf tmp

wr clrwdt

call GtDtBlk

call StData

decfsz tmp, 1
goto wr

call StopP
bsf PORTC, 3

return
.

snd

• Cifi rintii, ' vjci IV a La

GtDtBlk ;ca11 ReadIR

;call Get_Data0
;call delay2

call ReadIR

call Get_DataO
call delay2

call ReadIR

call Get_Datal
call delay2

call ReadIR

call Get_Data2
call delay2

call ReadIR

call Get_Data3
call delay2

return

; End

i pnr|y.tinn, JlUI lllg, LJaiu j uiituv^ii

StData movf Data_ByteO, w
call Dataln

movf Data_Bytel, w
call Dataln

movf Data_Byte2, w
call Dataln

movf Data Byte3, w
call Dataln

return

Dataln movwf

call

hvtf*uyi\s ,

OutByte ; Send Data
call GetAckP :

xxxx xxxW

Send Slave add
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return

; End—

WriteNVM

call WaitI2C

call StartP

movlw OxAO ; xxxx xxxW
mnvwf byte

OutByte
11 *\J V W 1

call

call GetAckP

;movlw 0x00

movf w_temp3, WREG
movwf byte
call OutByte ; Send Slave add
call GetAckP

return

;nd

Lect movlw

Oil Hlg

V

call Dataln

movlw 'e'

call Dataln

movlw 'c'

call Dataln

movlw 't'

call Dataln

movlw 'u'

call Dataln

movlw V

call Dataln

movlw 'e'

call Dataln

movlw V

call Dataln

movlw ';'

call Dataln

movlw "

call Dataln

call StopP
return

• 'p-xt Nrv String
'E'

, 1—Al. INU.

Ext movlw

call Dataln

movlw 'x'

call Dataln

movlw 't'

call Dataln

movlw 7

call Dataln

movlw 0x20

call Dataln

movlw •N'

call Dataln

movlw 'o'

call Dataln

movlw 7

call Dataln

movlw "

call Dataln

call StopP
return

Class movlw V
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call Dataln

movlw T

call Dataln

movlw 'a'

call Dataln

movlw 's'

call Dataln

movlw 's'

call Dataln

movlw 0x20

call Dataln

movlw 'S'

call Dataln

movlw 'e'

call Dataln

movlw y

call Dataln

movlw y

call Dataln

movlw V

call Dataln

movlw 'o'

call Dataln

movlw 'n'

call Dataln

movlw 7

call Dataln

call StopP
return

• 'Consultation Hours' String
Const movlw 'C

call Dataln

movlw 'o'

call Dataln

movlw 'n'

call Dataln

movlw y

call Dataln

movlw 't'

call Dataln

movlw "

call Dataln

movlw 'H'

call Dataln

movlw 'o'

call Dataln

movlw V

call Dataln

movlw Y

call Dataln

movlw 's'

call Dataln

movlw 7

call Dataln

call StopP
return

• 'TV^ct1 Srnticx, ItH lJU II lg>

Test movlw T

call Dataln

movlw 'e'

call Dataln

movlw V

call Dataln

movlw 't'

call Dataln

movlw 7
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ReadG

call

call

return

Dataln

StopP

-ReadData(Page 1)-

Movlw

Movwf

Call

Call

Movlw

Movwf

Call

Call

movf

Movwf

Call

Call

Call

Movlw

Movwf

call

call

call

call

movf

movwf

clrwdt

call

decfsz

goto

call

call

return

0x01

w_temp

J°°P

StartP

OxAO

byte
OutByte
GetAckP

w_temp3, WREG
byte
OutByte
GetAckP

StartP

OxAl

byte
OutByte
GetAckP

InByte
Display
Byte_No, w
tmp

read

tmp, 1
_r

NonAckP

StopP

ReadDatafPage 2>

Movlw 0x01

Movwf w_temp
Call Joop

Call

Movlw

Movwf

Call

Call

movf

Movwf

Call

Call

Call

Movlw

Movwf

call

call

call

call

movf

movwf

clrwdt

call

decfsz

goto
call

call

StartP

0xA2

byte
OutByte
GetAckP

w_temp3,WREG
byte
OutByte
GetAckP

StartP

0xA3

byte
OutByte
GetAckP

InByte
Display
Byte_No, w
tmp

read

tmp, 1
_rr

NonAckP

StopP

wait for lOOmS

xxxx xxxW

Send Slave add

xxxx xxxR

supply the slave addr

Read General Data

send HIGH to the SDA line to indicate NONACK

to tell the device that this is the last data.

wait for lOOmS

xxxx xxxW

Send Slave add

xxxx xxxR

supply the slave addr

Read General Data

, send HIGH to the SDA line to indicate NONACK

, to tell the device that this is the last data.
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return

wait for lOOmS

xxxx xxxW

read call AckP

call InByte
call delay4
call Display
return

Display movf byte, WREG
call DataLCD

return

ReadL

Movlw 0x01 ;
Movwf w_temp ;
Call Joop ;

Call StartP ;
Movlw OxAO ;
Movwf byte ;
Call OutByte ;
Call GetAckP ;
Movlw 0x00 ;
;movf w_temp3, WREG
Movwf byte ;
Call OutByte ;
Call GetAckP ;

Call StartP

Movlw OxAl ;
Movwf byte
call OutByte ;
call GetAckP

call InByte ;
call Display

readL movlw 0x08 ;
movwf tmp ;

readL clrwdt

call read ;
decfsz tmp, f ;
goto readL ;
call NonAckP ;

call StopP ;
return

Send Slave add

xxxx xxxR

supply the slave addr

Read Name of Lecturer

ReadE

send HIGH to the SDA line to indicate NONACK

to tell the device that this is the last data.

Movlw 0x01

Movwf w_temp

Call _loop ; wait for lOOmS

Call StartP

Movlw OxAO ; xxxx xxxW
Movwf

Call

byte
OutByte

Call GetAckP

Movlw 0x20

;movf w_temp3, WREG
Movwf byte
Call OutByte ; Send Slave add
Call GetAckP

Call StartP

Movlw OxAl ; xxxx xxxR
Movwf byte
call OutByte ; supply the slave addr
call GetAckP

call InByte ; Read Ext No
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readE

readE

ReadC

readC

readC

call

movlw

movwf

clrwdt

call

decfsz

goto

call

call

return

Movlw

Movwf

Call

Call

Movlw

Movwf

Call

Call

Movlw

;movf
Movwf

Call

Call

Call

Movlw

Movwf

call

call

call

call

movlw

movwf

clrwdt

call

decfsz

goto
call

call

return

ReadCH

Movlw

Movwf

Call

Call

Movlw

Movwf

Call

Call

Movlw

;movf
Movwf

Call

Call

Call

Movlw

Movwf

call

call

call

call

readCFI movlw

movwf

readCH clrwdt

Display
OxOC

tmp

read

tmp, f
_readE
NonAckP

StopP

0x01

w_temp

_loop

StartP

OxAO

byte
OutByte
GetAckP

0x30

w_temp3, WREG
byte
OutByte
GetAckP

StartP

OxAl

byte
OutByte
GetAckP

InByte
Display
OxOD

tmp

read

tmp,f
_readC
NonAckP

StopP

0x01

w_temp

_loop

StartP

OxAO

byte
OutByte

GetAckP

0x70

w_temp3, WREG
byte
OutByte
GetAckP

StartP

OxAl

byte
OutByte
GetAckP

InByte
Display
OxOB

tmp

send HIGH to the SDA line to indicate NONACK

to tell the device that this is the last data.

wait for lOOmS

xxxx xxxW

Send Slave add

xxxx xxxR

supply the slave addr

Read Class Session

send HIGH to the SDA line to indicate NONACK

to tell the device that this is the last data.

wait for lOOmS

xxxx xxxW

Send Slave add

xxxx xxxR

supply the slave addr

Read Consultation Hours
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call read

decfsz tmp, f
goto readCH

call NonAckP

call StopP
return

-end—

; 0.2 seconds with wreg = 0x01
; Loop for Delay
loop movwf w__temp

bsf

rlf

_loop call
decfsz

goto

return

STATUS, C
w__temp, 1 ; x 2
timer 1

w_temp,l
_loop

setupTimerl

timerl

timerl

loop Timerl

-Timerl (0.1s)-

movlw

movwf

return

movlw

movwf

movlw

movwf

bcf

bsf

0x30

T1CON

0x3C

TMR1H

OxBO

TMR1L

PIR1.0
T1CON.0

send HIGH to the SDA line to indicate NONACK

to tell the device that this is the last data.

so that if w_temp = 0, after rotate, w_temp= 1

, here if w_temp == 0, trouble! 255 time looping

; Clear Timerl overflow flag
; Start Timerl

clrwdt

btfss

goto

bcf

return

PIR1.0
loopTimerl
T1CON,0 ; Stop Timerl

timer2

; i2c_freq

WaitI2C

movlw

goto

OxFE

timerl

-WaitI2C 12C

Clrwdt

Movlw 0x00

Movwf i2c freq
btfsc i2c freq, 7
return

btfsc i2c freq, 6
return

btfsc i2c freq, 5
return

btfsc i2c freq, 4
return

btfsc i2c freq, 3
return

btfsc i2c freq, 2
return

nop

btfsc i2c freq, 1
return

nop

nop

btfsc i2c freq, 0
return

nop
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nop

nop

return

-end-

-StartP-

RETURN

-I2C

StartP ; bitl = SDA bitO = SCL

InByte

JnByte

Movlw HIGH_HIGH
Movwf I2C_PORT
Call WaitI2C

Call WaitI2C

movlw LOW_HIGH
movwf I2C_PORT
call WaitI2C

Movlw LOW_LOW
Movwf I2C_PORT
Call WaitI2C

return

end

InByte-

movlw 0x09

Movwf nbit

decf nbit, 1
btfsc

return

STATUS, Z

movlw HIGH_LOW
movwf 12C_PORT
call WaitI2C ;

movlw

movwf

rlf

bcf

call

HIGH_HIGH
I2C PORT

byte, 1
byte.O
WaitI2C

1 1 ->

1 l->

0 1 ->

;00->

RETURN
I2C

I2C

dec, skip if not zero

RETURN...

here nbit-8, 7, 6, 5,4,3,2, 1
1 0 0000 1000:0 1 -> 0000 0100

1 1 -> 0000 1100, release the line high

; rotate left

btfsc I2C_PORT, SDAJN ; 0000 0000
bsf byte,0 ;here* = V
call WaitI2C ;

1000 0000

movlw HIGH LOW ; 100000 1000:0 1 -> 0000 0100
movwf I2C PORT ;

call WaitI2C ;
goto InByte ;

—end I2C

;byte

—NonAckP I2C

NonAckP movlw HIGH LOW ; 1 0 -> 0000 1000 : 0 1 -> 0000 0100
movwf 12C PORT

call WaitI2C

movlw HIGH HIGH ;1 1 -> 0000 1100
movwf 12C PORT

call WaitI2C

call WaitI2C ;1 1 -> 0000 1100

movlw HIGH LOW ; 1 0 -> 0000 1000 : 0 1 -> 0000 0100
movwf I2C PORT

call WaitI2C

return ;RETURN
end I2C

'

StopP I2C

StopP movlw LOW LOW ; 0 0 -> 0000 0000
movwf I2C PORT

call WaitI2C
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AckP

movlw

movwf

call

movlw

movwf

call

call

return

movlw

Movwf

call

Movlw

Movwf

Call

Call

Movlw

Movwf

Call

return

GetAckP movlw

Movwf

call

movlw

movwf

call

btfsc

goto

call

movlw

movwf

call

return

; do something when
DeviceError

bcf

RESETMIC

nop

goto

; pass a byte to 'byte'

OutByte

_OutByt

PLow movlw

Movwf

Call

LOW_HIGH
12C_PORT
WaitI2C

HIGH_HIGH
12C_PORT
WaitI2C

WaitI2C

—End

•—AckP

LOWJ-OW
I2C_PORT
WaitI2C

LOW_HIGH
I2C_PORT
WaitI2C

WaitI2C

LOW_LOW
I2C_PORT
WaitI2C

End

-GetAckP

HIGHLOW

I2C_PORT
WaitI2C

0 1 ->0000 0100:1 0-> 0000 1000

1 1 -> 0000 1100

1 1 ->0000 1100

RETURN
12 C

I2C

0 0 -> 0000 0000

0 1 -> 0000 0100 : 1 0 -> 0000 1000

0 1 -> 0000 0100: 1 0-> 0000 1000

0 0 -> 0000 0000

RETURN

-I2.C

--I2C

1 0 -> 0000 0010 : 0 1 -> 0000 0001

(li

HIGH_HIGH ; 1 1 -> 0000 0011, release the SDA line
I2C_PORT ; to HIGH and then let the EEPROM decide

;to

WaitI2C ; {2! pull LOW orrelease HIGH...
I2C_PORT, SDA_IN ; 0000 0000 1000 0000
DeviceError ; here detect no ACK!
WaitI2C ; {3}
HIGH_LOW ; 1 0 -> 0000 1000 : 0 1 -> 0000 1000
12C_PORT ;
WaitI2C ; {4j

;RETURN
End I2C

device is not responding

PORTC, 0 ; clearing port c pin 0

RESETMIC

Looping until the WATCHDOG timer overflow, this will
resetting the micon

—OutByte
movlw 0x09

Movwf nbit

decf nbit,!
btfsc STATUS, Z
return

rlf

btfsc

goto

byte, 1
STATUS, C
PHigh

LOW_LOW
I2C_PORT
WaitI2C

I2C

nbit -> control looping

RETURN...

here nbit-8, 7, 6, 5, 4,3,2,1
rotate left, carry
bit<0> test, skip if clear
here, byte<0> = 1
here, byte<0> = 0
R3 = SCL, R2 = SDA

; 0 0 ->0000 0000
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PHigh

end

Movlw LOW HIGH

Movwf I2C PORT

Call WaitI2C

Call WaitI2C

Movlw LOW LOW

Movwf I2C PORT

Call WaitI2C

Goto _OutByt

movlw HIGH LOW

Movwf I2C PORT

Call WaitI2C

Movlw HIGH HIGH

Movwf I2C PORT

Call WaitI2C

Call WaitI2C

Movlw HIGH LOW

Movwf I2C PORT

Call WaitI2C

Goto _OutByt
end OutByte

0 1 ->0000 0100 : 1 0 ->0000 1000

0 1 ->0000 0100 :1 0 ->0000 1000

;0 0 ->00000000

1 0 ->0000 1000 :0 1 ->0000 0100

1 1 ->0000 1100

1 1 ->0000 1100

1 0 ->0000 1000 :0 1 ->0000 0100

I2C
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APPENDIX B



Transmitter Code

Programmer: Ahmad Rizal bin Muhammad Arif
ID No: 1922

Program: Electrical & Electronics Engineering
Company: Universiti Teknologi PETRONAS

Note: This code is the transmitter code. The routine is generating IDC Infra Red protocol.
The main routine takes value form a PC then transmit the value

#include<P16F84A.inc>

; -Reserving Register
cblock 0x20 ;start ofgeneral purpose registers

countl ;used in delay routine
counta ;used in delay routine
countb

count

Delay_Count
Bit_Cntr
Data^Byte
Dev_Byte
Rev Byte
Pulse

temp

endc

CONTROL Equ PORTA
IR PORT Equ PORTA
IR Out Equ 1
CO Equ 2
Cl Equ 3

org 0x00

goto Setup

Setup bsf STATUS, RPO Select Bankl

movlw OxOC

movwf TRISA Select pin 2 & 3 as an input, other as an ou
movlw OxFF

movwf TRISB Select PORTB as an inputs
bcf STATUS, RPO

call wait3

goto main

main nop

call Start bit Check for Start Bit

movf PORTB, w Read from Port B and put in working regis!
movwf Data Byte
call TX_Start Transmit Start Pulse

call SendB Transmit Data

call Start bit Check for Start Bit

movf PORTB, w Read from Port B and put in working regis
movwf Data Byte
call TXjStart Transmit Start Pulse

call SendB Transmit Data

goto
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TX_Start

Infra Red Routine

movlw d'92'

call IR_pulse
movlw d'23'

call NO_pulse
retlw 0x00

TX_One movlw d'461

call IR pulse
movlw d'23'

call NO_pulse
retlw 0x00

TX_Zero movlw d'23'

call IRjmlse
movlw d'23'

call NO_pulse
retlw 0x00

TX_Stop movlw d*69'

call IR_pulse
movlw d'23'

call NO_pulse
retlw 0x00

IR_pulse
MOVWF count ;

irloop BSF

NOP

NOP

NOP

NOP

NOP

NOP

NOP

IR_PORT, IR_Out

BCF IR_PORT, IR_Out
NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP •

NOP •

DECFSZ count,F

GOTO irloop
RETLW 0

NO_pulse
MOVWF count ;

irloop2 BCF

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

NOP

IR_PORT, IR_Out

Pulses the IR led at 38KHz

Doesn't pulse the IR led
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BCF IR PORT, IR Out

NOP ;

NOP ;
NOP ;

NOP ;
NOP ;

NOP ;
NOP

NOP

NOP ;
NOP ;
DECFSZ count,F
GOTO irloop2
RETLW 0

irfrsi Rf*H Rnutinp PnH

Start_bit clrwdt

JJlLu I\.tU l\.UULJilt l^jju

btfss CONTROL, Cl
goto main

retlw 0x00

Stop_bit clrwdt

btfsc CONTROL, Cl

goto main

retlw 0x00

SendB movlw 0x08

movwf temp
_SendB clrwdt

btfss Data__Byte,7
goto sendB

call TX_One
rlf Data_Byte, 1

_sendB decfsz temp, 1
goto _SendB
return

sendB call TX_Zero
rlf Data_Byte, 1
goto _sendB

wait movlw OxFF

movwf Dev_Byte
„wait clrwdt

decfsz Dev_Byte, f
goto _wait
return

wait2 movlw OxFF

movwf Rcv_Byte
_wait2 cli-wdt

call wait

decfsz Rcv_Byte, f
goto _wait2
return

wait3 movlw 0x12

movwf Rcv_Byte
_wait3 clrwdt

call wait

decfsz Rcv_Byte, f
goto _wait3
return

end

72



APPENDIX C



Software Code

/*

//

// Programmer; Ahmad Rizal bin Muhammad Arif
// ID No: 1922

// Program: Electrical& Electronics Engineering
// Company: Universiti Teknologi PETRONAS
//

// Note; This code is the software code

//
// */

// !DCParallel4Dlg.cpp : implementation file
//

#include "stdafx.h"

#include "IDCParallel4.h"

#include "IDCParalleHDlg.h"
#include <conio.h>

#define DATAPORT 0x378 // data printer port
#define CONTROL DATAPORT+2 // control printer port

#ifdef_DEBUG
#define new DEBUG_NEW
#undefTHIS_FILE
static char THIS_FILE[] = _FILE_;
#endif

li/lilllllllilli/ll/Illilli/li/lllll/ll/ll/IIIIIIililllilli/lilltlllillllllil

IICAboutDlg dialog used for App About

class CAboutDlg : public CDialog

{
public:

CAboutDlgO;

// Dialog Data
//{{AFX_DATA(CAboutDlg)
enum { IDD = IDD_ABOUTBOX };
//}}AFX_DATA

// ClassWizard generated virtual function overrides
//{(AFX_VIRTUAL(CAboutDlg)
protected:
virtual void DoDataExchange<CDataExchange* pDX); // DDX/DDV support
//}}AFX_VIRTUAL

// Implementation
protected:

//{{AFX_MSG(CAboutDlg)
//}}AFX_MSG
DECLARE_MESSAGEJvlAPO

};

CAboutDlg::CAboutDlg(): CDialog(CAboutDlg::IDD)

{
// {{AFX_DATA_INIT(CAboutDlg)
//}}AFX_DATAJNIT

}

void CAboutDlg::DoDataExchange(CDataExchange* pDX)
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CDialog::DoDataExchange(pDX);
//{{AFX_DATA_MAP(CAboutDlg)
//}}AFX_DATA_MAP

}

BEGIN_MESSAGE_MAP(CAboutDlg,CDialog)
//{{AFXJvlSGJVlAP(CAboutDlg)

// No message handlers
//}}AFX_MSG_MAP

END_MESSAGE_MAP()

lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll

IICIDCParallel4Dlg dialog

CIDCParallel4Dlg:;CIDCParallel4Dlg(CWnd* pParent /*=NULL*/)
: CDialog(CIDCParallel4Dlg::IDD, pParent)

{
//{{AFX_DATAJNIT(CIDCParallel4D!g)
mjecturer = _T("");
m_extno = _T("");
m_dayl =_T("");
m_slotl - FALSE;
mjimel = _T("");
rn_venuel =_T("");
m_coursel =_T("");
m_slot2 = FALSE;
m_day2 = _T("");
m__time2 = _T("");
m_venue2 = _T("");
m_course2 =_T("");
m_constl = FALSE;
m_const2 = FALSE;
m_day4 - _T("");
m_time3 = _T("");

m_time4 = _T("");
m_day3 = _T("");
m_course5 = _T("");
m_day5 = _T("");
m_dy = jr(""};
ni_venue5 = _T("");
m_time5 - _T("");
mjest = FALSE;
m_month -_T("");
m_year = _T("");
m_msg = FALSE;
m_msgbox = _T("");
//}}AFXJ)ATAJNIT
// Note that Loadlcon does not require a subsequent Destroylcon in Win32
mjilcon = AfxGetApp()->LoadIcon(IDR_MArNFRAME);

}

void CIDCParallel4Dlg::DoDataExchange(CDataExchange* pDX)

{
CDialog::DoDataExchange(pDX);
// {{AFXJ3ATAJV1AP(CIDCParallel4Dlg)
DDX_Text(pDX, IDC_LECTEDIT1, mjecturer);
DDV_MaxChars(pDX, mjecturer, 16);
DDX_Text(pDX, IDCJ3XTNOEDIT2, m_extno);
DDV_MaxChars(pDX, m_exmo, 4);
DDX_CBString(pDX, IDC_DAY1, m_dayl);
DDV_MaxChars(pDX, m_dayl, 8);
DDX_Check(pDX, IDCJSLOT1, m_slotl);
DDX_CBString(pDX, IDC_TIME1, mjimel);
DDX_Text(pDX, IDC_VENUE1, m^venuel);
DDVJvlaxChars(pDX, m_venuel, 16);
DDXJText(pDX, IDCJCOURSEl, m_coursel);
DDV_MaxChars(pDX, m_coursel, 10);
DDX_Check(pDX, IDCJSLOT2, m_slot2);
DDX_CBString(pDX, IDCJ3AY2, m_day2);
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}

DDV_MaxChars(pDX, m_day2, 3);
DDX_CBString(pDX, IDCJTIME2, mjime2);
DDX_Text(pDX, IDC_VENUE2, m_venue2);
DDVJVIaxChars(pDX, m_venue2, 16);
DDXJext(pDX, IDC_C0URSE2, m_course2);
DDVJMaxChars(pDX, m_course2, 16);
DDX_Check(pDX, IDC_C0NST1, m_constl);
DDXj:heck(pDX, IDC_C0NST2, m_const2);
DDX_CBString(pDX, IDCJ3AY4, m_day4);
DDX_CBString(pDX, IDCJTIME3, mjime3);
DDX_CBSfring(pDX, IDC_TIME4, mjime4);
DDX_CBSfring(pDX, IDC_DAY3, m_day3);
DDX_Text(pDX, IDCJC0URSE5, m_course5);
DDX_CBString(pDX, IDC_DAY5, m_day5);
DDX_CBString(pDX, IDC_DY, m_dy);
DDXJText(pDX, IDC_VENUE5, m_venue5);
DDX_CBString(pDX, IDCJTME5, mjime5);
DDX_Check(pDX, IDCJTEST, mjest);
DDX_CBString(pDX, IDCJvIONTH, m_month);
DDX__CBString(pDX, IDC_YR, m_year);
DDX_Check(pDX, IDCJMSG, m_msg);
DDXJText(pDX, IDCJvtSGBOX, m_msgbox);
//}}AFXJDATA_MAP

BEGrN_MESSAGEJMAP(CIDCParallel4Dlg,CDialog)
//{{AFX_MSG_MAP(CIDCParallel4Dlg)
ON_WM_SYSCOMMAND()
ON_WM_PAINT()
ON_WM_QUERYDRAGICON()
ONJ3N__CLICKED(IDCJTRANSMIT,OnTransmit)
//}}AFX_MSG_MAP

END_MESSAGE_MAP()

lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll

IICIDCParallel4Dlg message handlers

BOOLCIDCParallel4Dlg::OnInitDialog()

{
CDialog::OnInitDialog();

// Add "About..." menu item to system menu.

// 1DMAB0UTB0X must be in the system command range.
ASSERT{(IDM_ABOUTBOX & OxFFFO) = IDM_ABOUTBOX);
ASSERT(IDM_ABOUTBOX < OxFOOO);

CMenu* pSysMenu = GetSystemMenu(FALSE);
if(pSysMenu l-NULL)

{
CString strAboutMenu;
strAboutMenu.LoadSfring(IDS_ABOUTBOX);
if (IstrAboufMenu.IsEmptyO)

{
pSysMenu->AppendMenu(MFJSEPARATOR);
pSysMenu->AppendMenu(MF_STRTNG, IDM_ABOUTBOX, strAboutMenu);

}
}

// Set the icon for this dialog. The framework does this automatically
// when the application's main window is not a dialog
SetIcon(rn_hIcon, TRUE); // Set big icon
Setlcon(m_hlcon, FALSE); // Set small icon

// TODO: Add extra initialization here

return TRUE; // return TRUE unless you set the focus to a control

}

void CIDCParallel4Dlg::OnSysCommand(UINT nID, LPARAM IParam)
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}

if ((nID & OxFFFO) = IDM_ABOUTBOX)
{

CAboutDlg dlgAbout;
dlgAbout.DoModalQ;

f
else

CDialog::OnSysCommand(nID, IParam);

// If you add a minimize button to your dialog, you will need the code below
// to draw the icon. For MFC applications using the document/view model,
// this is automatically done for you by the framework.

void CIDCParallel4Dlg::OnPaint()

if (IsIconic())

{

else

{

CPaintDC dc(this); // device context for painting

SendMessage(WMJCONERASEBKGND, (WPARAM) dc.GetSafeHdc(), 0);

// Center icon in client rectangle
int cxlcon = GetSystemMetrics(SMJ^XICON);
int cylcon = GetSystemMetrics(SM_CYICON);
CRect rect;
GetClientRect(&rect);
int x = (rect.Width() - cxlcon + 1) / 2;
int y = (rect.Height() - cylcon + 1) / 2;

// Draw the icon

dc.DrawIcon(x, y, mjilcon);

CDialog::OnPaint();

}

// The system calls this to obtain the cursor to display while the user drags
// the minimized window.

HCURSOR CIDCParallel4Dlg: :OnQueryDragIcon()

{
return (HCURSOR) mjilcon;

}

void CIDCParallel4Dlg::IDCData(char data)

{
_outp(CONTROL,0x00);
Sleep(5);
_outp(DATAPORT,dafa);
Sleep(lO);
_outp(CONTROL,0x02);
Sleep(lO);

}

void CIDCParallel4Dlg::IDCInfo(int data)

{
_outp(CONTROL,0x00);
Sleep(5);
_outp(DATAPORT,data);
Sleep(lO);
_outp(CONTROL,0x02);
Sleep(lO);

}
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voidCIDCParallel4Dlg::OnTransmit()
{

// TODO: Add your control notification handler code here
Update Data(true);
IDCInfo(OxOO);
Sleep(lOOO);

mt

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

int

gthlecturer = mJecturer.GetLength();
gthlectblk = lgthlecturer/4;
gthlectblkR - Igthlecturer % 4;

gthextno = m_extno.GetLength();

gthcoursel = m_coursel ,GetLength();
gthcourselblk = Igthcoursel /4;
gthcourselblkR = Igthcoursel %4;

gthdayl = m_dayl .GetLength();
gthdaylblk = lgthdayl/4;
gthdaylblkR = lgthdayl %4;

gthtimel = mjimel.GetLength();
gthtimelblk = lgthtimel I A;
gthtimelblkR = Igthtimel % 4;

gthvenuel = m_venuel .GetLength();
gthvenuelblk = Igthvenuel / 4;
lgthvenuelblkR= Igthvenuel %4;

gthcourse2 = m_course2.GetLength();
gthcourse2blk = lgthcourse2 / 4;
gthcourse2blkR = lgthcourse2 % 4;

gthday2 = m_day2.GetLength();
gthday2blk = lgthday2 / 4;
gthday2blkR = lgthday2 % 4;

gthtime2 = mJime2.GetLength();
gthvenue2 = m_venue2.GetLength();
gthday3 = m_day3.GetLength();
gthtime3 = mJime3.GetLength();

gthday4 = m_day4.GetLength();
gthday4blk = lgthday4 / 4;
gthday4blkR = lgthday4 % 4;

gthtime4 = mjime4.GetI_ength();
gthtime4blk = lgthtime4 / 4;
gthtime4blkR = lgthtime4 % 4;

gthcourse5 = m_course5.GetLength();
gthcourse5blk = lgthcourse5 / 4;
gthcourse5blkR = lgthcourse5 % 4;

gthday5 = m_day5.GetLength();
gthday5blk = lgthday5 / 4;
gthday5blkR = lgthday5 % 4;

gthdy = m_dy.GetLength();
gthdyblk = Igthdy / 4;
gthdyblkR = lgthdy%4;

gthmonth = m_month.GetLength();
gthmonthblk = Igthmonth / 4;
gthmonthblkR - Igthmonth % 4;

gthyear = m_year.GetLength();
gthyearblk = Igthyear / 4;
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int IgthyearblkR = Igthyear% 4;

int Igthtime5 = mjime5.GetLength();
int lgthtime5blk = lgthtime5 14;
int IgfhtimeSblkR - lgthtime5 % 4;

int lgthvenue5= m_venue5.GetLength();
int lgthvenue5blk = lgthvenue5 / 4;
int lgthvenue5blkR= lgthvenue5 % 4;

int Igthmsg= m_msgbox.GetLength{);
int Igthmsgblk = Igthmsg / 4;
int IgfnmsgblkR = Igthmsg %4;

//Lecturer Name

if (Igthlecturer NO)
{

if(lgthlectblkR = 0)
{

IDCStBlk(OxOO, Igthlectblk, Igthlecturer-1);

for(int a=0; a<lgthlecturer; a++)
{

IDCData(mJecturer[a]);
Sleep(20);

IDCData(0x20);
S!eep(250);

if(lgthlectblkR>0)
{

IDCStBlk(0x00, Igthlectblk + 1, Igthlecturer - 1);

for(int al=0; aKlgthlecturer; al++)
{

IDCData(mJecturer[al ]);
Sleep(20);

if{lgthlectblkR==l)

{
forfint a2=0; a2<3; a2++)

{
IDCData(0x20);
Sleep(20);

}

if(lgthlectblkR = 2)
{

forfint a3=0; a3<2; a3++)

{
IDCData(0x20);
Sleep(20);

}

if (lgthlcctblkR = 3)
{

forfint a4=0;a4<l;a4++)
{

IDCData(0x20);
Sleep(20);
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}

//Sleep(150);

//Ext No:

if(lgthextno == 4)
{

IDCData(0x20);
Sleep(250);

IDCStBlk(0x01, 0x01, lgthextno - 1);

for(int b=0; b<lgthextno; b++)

{
IDCData(m_extno[b]);
Sleep(20);

IDCData(0x20);
Sleep(250);

}

//Sleep(250);

//Class Session

//Slotl

if(m_slotl = l)
{

IDCStBlk(2, 2, 6);

IDCData('S');Sleep(20);IDCData(T);Sleep(20);IDCData('o');Sleep(20);IDCData(t');Sleep(20);
IDCData(");Sleep(20);IDCData('l');Sleep(20);IDCData(':');Sleep(20);IDCData(");S1eep(20);
IDCDataC f);Sleep(750);

//Course 1

if(lgthcoursel != 0)

{

if(lgthcourselblkR = 0)

{
IDCStBlk(3, Igthcoursel blk, Igthcoursel - 1);

for (int c=0; c<lgthcourse 1; C++)

{
IDCData(m_course 1[e]);
Sleep(20);

IDCData(0x20);
Sleep(250);

}

if(lgthcourselblkR>0)

{
IDCStBlk(3Jgthcourselblk+ 1, Igthcoursel - 1);

for(fntcl=0;cl<lgthcoursel;cl++)

{
EDCData(m_course 1[cl ]);
Sleep(20);

if(lgthcourselblkR==l)

{
for(intc2=0;c2<3;c2++)
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}
}

//S!eep(500);

//Day 1
if(lgthdayl 1=0)

{

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthcourselblkR==2)

{
for (int c3=0; c3<2; c3++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthcourselblkR==3)

{
for(int c4-0; c4<l; c4++)

{
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);

iftlgthdaylblkR==0)

<

IDCStBlk(0x04, Igthdayiblk, Igthdayl -1);

for (int d=0; d<lgthdayl; d++)

{
IDCData<mj3ayl[d]);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lg£hdaylblkR>0)
{

IDCStBlk(0x04, Igthdayiblk + 1, Igthdayl - 1);

for(intdl=0;dl<lgthdayl;dl++)

!
IDCData(m_dayl[dl]);
Sleep(20);

if(lgthdaylblkR=l)
{

for(intd2=0;d2<3;d2++)

{
IDCData(0x20);
Sleep(20);

}
}
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//Sleep(500);

//Timel

if(lgthtimel !=0)

if(lgthdaylblkR=2)

{
forfjnt d3=0; d3<2; d3++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthdaylblkR = 3)

{
for(intd4=0;d4<l;d4++)

{
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);

ifflgthtimelblkR —0)

{
IDCStBlk(0xO5, Igthtimelblk, Igthtimel - 1);

for(int e=0; e<lgthtimel; e++)

{
IDCData(mjimel[e]);
Sleep(20);

}

IDCData(0x20);
Sleep(250);

}

if(lgthtimelblkR>0)

{
IDCStBlk(0x05, Igthtimelblk + 1, Igthtimel -1);

for(int e1=0; e1<lgthtime 1; el ++)

{
IDCData(mjimel[el]);
S1eep(20);

}

if(lgthtimelblkR==3)

{
forfjnt e2=0;e2<l;e2++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthtimelblkR==2)

for(inte3-0;e3<2;e3++)

{
IDCData(0x20);
Sleep(20);

}
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}

//Sleep(500);

//Venue1

ifflgthvenuel != 0)

{

if(lgthtimelblkR==l)

fortfnt e4=0; e4<3; e4++)

{
IDCData(0x20);
S!eep(20);

}

IDCData(0x20);
Sleep(250);

if(]gthvenuelblkR==0)

{

IDCStBlk(0x06, Igthvenuel blk, Igthvenuel -1);

forfjnt f=0; Mgthvenuel; f++)

{
IDCData(m_venuel[f]);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lgthvenuelblkR>0)

{

IDCStBlk(0xO6,lgthvenuelblk+l, Igthvenuel -1);

forfint fl=0; fKlgthvenuel; fl++)

{
IDCData(m_venuel [fl ]);
Sleep(20);

}

if(lgthvenuelblkR-=3)

{
for(intf2=0;f2<l;f2++)

{
IDCData(0x20);
Sleep(20);

}

if(lgthvenuelblkR=2)

{
forfjnt f3=0;f3<2;f3++)

{
IDCData(0x20);
Sleep(20);

}

if{lgthvenuelblkR=l)

{
for(intf4=0;f4<3;f4++)
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IDCData(0x20);
Sleep(250);

//Sleep(500);

//Class Session

//Slot 2

if(m_slot2 = l)
{

IDCStBlk(7, 2, 6);

IDCData(0x20);
Sleep(20);

IDCData(,S');Sleep(20);IDCData(,l,);Sleep(20);IDCData('o,);Sleep(20);IDCData('t');Sleep(20);
IDCData(");Sleep(20);IDCData('2l);Sleep(20);IDCData(':,);Sleep(20);IDCData(");Sleep{20);
IDCDataC ');Sleep(750);

//Course2

if(lgthcourse2 != 0)

{

if(lgthcourse2blkR—0)

{
IDCStBlk(8, lgthcourse2blk, lgthcourse2 -1);

for (int g=0; g<lgthcourse2; g++)

{
IDCData(mjx>urse2[g]);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lgthcourse2blkR>0)

{
IDCStBlk(8, lgthcourse2blk + 1, lgthcourse2 - 1);

for (int g=0; g<lgthcourse2; g++)

{
IDCData(m_course2[g]);
Sleep(20);

}

ii'(lgthcourse2blkR=3)

{
for(intg=0;g<l;g++)

{
IDCData(0x20);
Sleep(20);

}
}

if (lgthcourse2blkR == 2)
{

for (int g=0; g<2; g++)

{
IDCData(0x20);
Sleep(20);

}
}
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}
!
//Sleep(500);

//Day2
if(lgthday2 != 0)

{

if(lgthcourse2blkR==l)
{

forfjnt g=0;g<3;g++)

i
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lgthday2blkR = 0)

{
IDCStBlk(9, lgthday2blk, lgthday2 -1);

forfint h=0; h<lgthday2; h++)

{
IDCData(m_day2[h]);
Sleep(20);

IDCData(0x20);
Sleep(250);

}

if(1gthday2blkR > 0)

{
IDCStBlk(9, lgthday2blk + 1, lgthday2 -1);

for(int h=0; h<lgthday2; h++)

{
IDCData(m_day2[h]);
Sleep(20);

if(lgthday2blkR = 3)

{
for(inth-0;h<l;h++)

{
IDCData(0x20);
Sleep(20);

}
}

ifr;igthday2blkR== 2)

{
forfjnt h=0;h<2;h++)

!
IDCData(0x20);
SIeep(20);

}

if(lgthday2blkR—1)

{
for(inth=0;h<3;h++)

{
IDCData(0x20);
Sleep(20);

1
}
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}

//Sleep(500);
//Time2

if(lgthtime2 != 0)

{

IDCData(0x20);
Sleep(250);

int lgthtime2blk = lgthtime2 / 4;
int lgthtime2blkR = lgthtime2 % 4;

if(lgthtime2blk-=0)

{
IDCStBlkfOxOA, lgthtime2blk, lgthtime2 -1);

for(int i=0; i<lgthtime2; i++)

{
IDCData(mJime2[i]);
Sleep(20);

!

IDCData(0x20);
Sleep(250);

}

if(lgthtime2blkR>0)

{
IDCStBlkfOxOA, lgthtime2blk + 1, lgthtime2 - 1);

forfjnt i-0; i<lgthtime2; i++)

!
IDCData(mJime2[i3);
Sleepf20);

//Sleep{500);
//Venue2*/

if(lgthtime2blkR —3)
{

for(inti=0;i<l;i++)

{
IDCData(0x20);
Sleep(20);

}

if(lgthtime2blkR — 2)
{

for(inti=0;i<2;i++)

{
IDCData(0x20);
Sleep(20);

}

if(lgthtime2blkR—1)

{
forfjnt i=0;i<3;i++)

{
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);
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if(lgthvenue2!-0)

int lgthvenue2blk = lgthvenue2 / 4;
int lgthvenue2blkR = lgthvenue2 % 4;

if(lgthvenue2blkR== 0)

{
IDCStBlk(Ox0B, lgthvenue2blk, lgthvenue2 -1);

forfint j=0; j<lgthvenue2; j++)

{
IDCData(m_venue2[j]);
Sleep(20);

}

IDCData(0x20);
Sleep(250);

}

if(lgthvenue2blkR > 0)
{

IDCStBlkfOxOB, lgthvenue2blk + 1, lgthvenue2 -1);

forfint j=0; j<lgthvenue2; j++)

}

IDCData(m_venue2[j]);
Sleep(20);

ifflgthvenue2blkR==3)
{

for(intj=0;j<l;j++)

{
IDCData(0x20);
Sleep(20);

I
}

if(lgthvenue2blkR = 2)

{
forfint j=0;j<2;j++)

{
IDCData(0x20);
Sleep{20);

if(lgthvenue2blkR—1)

{
for(intj=0;j<3;j++)

{

IDCData(0x20);
Sleep(250);

//Sleep(500);
//Consultation Hour

if(m_constl = 1)

{
IDCStBlk(0x0C, 3,0x0B);
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IDCDataCC1); Sleep(20); IDCData('o'); Sleep(20); IDCData('n'); S3eep(20); IDCData('s');
Sleep{20);

IDCData('t'); Sleep(20); IDCData('.'); Sleep(20); IDCDataf '); Sleep(20); IDCDatafH'); Sleep(20);
IDCData('o'); Sleep(20); IDCDataOu'); Sleep(20); IDCData(V); Sleep(20); IDCData(':');

Sleep(20);
IDCData(0x20); Sleep(750);

//Day3
if(lgthday3 != 0)

{
int lgthday3blk = lgthday3 / 4;
int lgthday3blkR = lgthday3 % 4;

if(jgthday3b!kR==0)

{
IDCStB!k(0x0D, lgthday3blk, lgthday3 -1);

for(int k=0; k<lgthday3; k++)

S
IDCData(m_day3[k]);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lgthday3blkR > 0)

{

//Sleep(500);

IDCStBlk(Ox0D, lgthday3blk + 1,3gthday3 - 1);

forfint kl=0; kl<lgthday3; kl++)

{
IDCData(m_day3[kl]);
Sleep(20);

if(lgthday3blkR = 3)

{
for(intk=0;k<l;k++)

{
IDCData(0x20);
Sleep(20);

I
}

itrigthday3blkR==2)

{
for(intk=0;k<2;k++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthday3blkR==l)

{
forfint k=0;k<3;k++)
{

}
}

IDCData(0x20);
Sleep(250);
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}

//Time3

if(lgthtime3 != 0)
{

int lgthtime3blk = lgthtime3 / 4;
int lgthtime3blkR = lgthtime3 % 4;

ifflgthtime3blkR = 0)

{
IDCStBlkfOxOE, lgthtime3blk, lgthtime3 - 1);

for(int 1=0;Klgthtime3; 1++)
{

IDCData(mjime3[l]);
Sleep(20);

IDCData(0x20);
Sleep(20);

}

if(lgthtime3blkR>0)
{

IDCStBlkfOxOE, lgthtime3blk + 1, lgthtime3 -1);

for(int 1=0;Klgthtime3; 1++)

{
IDCData(m_time3[l]);
SIeep(20);

if(lgthtime3blkR = 3)

{
forfint 1=0;1<1;1++)

!
IDCData(0x20);
Sleep(20);

}
}

i1tlgthtime3blkR = 2)

{
for(intl=0;K2;l++)
{

IDCData(0x20);
Sleep(20);

}
}

if(lgthtime3blkR=l)

{
forfint 1=0;1<3;1++)

{
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(m_const2 = 1)

{
//Consultation Hour 2

Sleep(500);
IDCStBlkfOxOF, 3, OxOB);



IDCDataCC1); Sleep(20); IDCData('o'); Sleep(20); IDCDatafn'); S3eep(20); IDCData('s');
Sleepf20);

IDCDataCf); Sleep(20); IDCDataC.1); Sleep(20); IDCDataC '); Sleep(20); IDCData(*H'); Sleep(20);
IDCData(*o'); Sleep(20); IDCData('u'); SIeep(20); IDCData(V); Sleep(20); IDCDataC:1);

Sleep(20);
IDCData(0x20); Sleep(750);

//Day4
if(lgthday4 != 0)

{

if(lgthday4blkR = 0)

{
IDCStBlkfOxlO, lgthday4blk, lgthday4 -1);

forfint m=0; m<lgthday4; m++)

{
IDCData(m_day4[m]);
Sleep(20);

}

IDCData(0x20);
Sleep(250);

}

itrigthday4blkR > 0)

{
IDCStBlkfOx 10, Igthday4blk + 1, lgthday4 -1);

for(int m=0; m<lgthday4; m++)

{
IDCData(m_day4[m]);
Sleep(20);

}

if(lgthday4blkR = 3)

{
for(m=0;m<l;m++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthday4blkR —2)

{
for(m=0;m<2;m++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthday4blkR=l)

{
for(m=0; m<3; m++)

{
IDCData(0x20);
Sleep{20);

}

//Time4

//Sleep(500);
if(lgthtime4 != 0)

!DCData(Ox20);
Sleep(250);
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Sleep(20);

{

}

if(lgthtime4blkR == 0)

{
IDCStBlk(0xl 1, lgthtime4blk, lgthtime4 -1);

for(int m=0; m<lgthtime4; m++)

{
IDCData(mJime4[m]);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lgthtime4blkR>0)

{
IDCStBlk(Oxl 1, lgthtime4blk+ 1, lgthtime4 -1);

for(int m=0; m<lgthtime4; m++)

{
IDCData(m_time4[m]);
Sleep(20);

!

if(lgthtime4blkR = 3)

{
for(int m=0; m<l; m++)

{
IDCData(0x20);
Sleep(20);

}

Uj1gthtime4blkR—2)

{
forfint m=0; m<2; m++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthtime4blkR — 1)

{
forfjnt m=0; m<3; m++)

{

IDCData(0x20);
Sleep(250);

IDCDataf0x20);
Sleep(20);

//Test

ifljnjest== 1)

{
IDCStBlk(0xl2, 0x02, 0x04);

IDCData(T); Sleepf20); IDCData('e'); Sleep{20); IDCDataCs1); Sleep(20); IDCDataCt1};

IDCDataC:1); Sleep(20); IDCDataC');Sleepf20); IDCDataf 0; Sleep(20); IDCDataf '); Sleep(20);
IDCDataf"); Sleep(750);

ifflgthcourseS != 0)
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if(lgthcourse5blkR = 0)

{
IDCStBlk(0xl3, lgthcourse5blk, lgthcourse5 -1);

for(int n=0; n<lgthcourse5; n++)

{
IDCData(m_couTse5[n]);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lgthcourse5blkR>0)

{
IDCStBlkfOxU, lgthcouTse5blk+ 1, lgthcourse5 -1);

forfint n=0; n<lgthcourse5; n++)

}

IDCData(m_course5[n]);
Sleep(20);

itTlgthcourse5blkR==3)

{
forfint n=0;n<l;Ti++)

{
IDCData(0x20);
S1eep(20);

}
}

if(lgthcourse5blkR == 2)

{

}

forfint n=0; n<2; n++)

{
IDCData(0x20);
Sleep(20);

}

if(lgthcourse5blkR=l)

{
forfint n=0;n<3;n++)

{
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);

//Sleep(500);

//Day5
if(lgthday5 != 0)

{
if(lgthday5blkR==0)

{
IDCStBlk(0xl4, lgthday5blk, lgthday5 -1);

forfint o=0; o<lgthday5; o++)

{
IDCData(m_day5[o]);
Sleep(20);
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IDCData(0x20);
Sleep(250);

if(lgthday5blkR > 0)

{
IDCStBlk(0xl4, lgthday5blk + 1, lgthday5 -1);

forfint o=0; o<lgthday5; o++)

{
IDCData(m_day5[o]);
Sleep(20);

}

if(lgthday5blkR = 3)

{
for(into=0;o<l;o++)

{
IDCData(0x20);
Sleep(20);

I
}

if(lgthday5blkR-=2)

{
for(int o=0; o<2; o++)

{
IDCData(0x20);
Sleep(20);

il(lgthday5blkR=l)

{
forfint o=0; o<3; o++)

{
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);

//Date

//Sleep(500);
iftjgthdy !=0 && Igthmonth !=0 && lgthyear !=0)
{

IDCStBlk(0xl5, 0x02, 0x07);

IDCData(m_dy[0]); Sleep(20); IDCData(m_dy[l]); Sleep(20);
IDCData(V'); Sleep(20);
IDCData(m_month[0]); Sleep(20); IDCData(m_month[l]); Sleep(20);
IDCDataC/'); Sleep(20);
IDCData(rn_year[0]); Sleep(20); IDCData(m_year[l]); Sleep(20);
IDCData(0x20); Sleep(250);

}

//Time5

//Sleep(500);
if(lgthtime5 != 0)

{
if(lgthtime5blkR = 0)

{
lDCStBlk(0xl6, lgthtime5blk,Sgthtime5 -1);

forfint p=0; p<lgthtime5; p++)
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IDCDatafmJime5[p]);
Sleep(20);

IDCData(0x20);
Sleep(20);

if(lgthtime5blkR > 0)

!
IDCStBlk(0xl6, lgthtime5blk + 1, lgthtime5 - 1);

for(int p=0; p<lgthtime5; p++)

{
IDCDatafmJime5[p]);
Sleep(20);

}

if(lgthtime5blkR=3)
{

for(intp=0;p<l;p++)

{
IDCData(0x20);
Sleep(20);

}

//Venue5

//Sleep(500);
ifljgthvenue5 != 0)
{

if(lgthtime5blkR = 2)

{
for(intp=0;p<2;p++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthtime5blkR = 1)

{
forfint p=0;p<3;p++)

{
IDCData(0x20);
Sleep(20);

IDCData(0x20);
Sleep(250);

if(lgthvenue5blkR==0)

{
IDCStBlk(0xl7, lgthvenue5blk, lgthvenue5 -1);

forfint q=0; q<lgthvenue5; q++)

{
IDCData(m_yenue5[q]);
Sleep(20);

IDCData(0x20);
Sleep(20);

}

if(lgthvenue5blkR > 0)
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}

IDCStBlk(0xl7, !gthvenue5blk + 1, ]gthvenue5 -1);

forfint q=0; q<lgthvenue5; q++)

{
IDCData(m_venue5[q]);
Sleep(20);

}

if(lgthvenue5blkR = 3)

{
for(intq=0;q<l;q++)

{
IDCData(0x20);
Sleep(20);

}

if(lgthvenue5blkR==2)

{
for(intq=0;q<2;q++)

{
IDCData(0x20);
Sleep(20);

}
}

if(lgthvenue5blkR=l)

{
for(intq=0;q<3;q++)

{
IDCData(Ox20);
Sleep(20);

}

IDCData(0x20);
Sleep(250);

//Away Message
//Sleep(500);
if(m_msg = 1)
{

iftlgthmsg != 0)

if(lgthmsgb1kR=0)

{
IDCStBlk(0xl8, Igthmsgblk, Igthmsg - 1);

forfint r=0; r<lgthmsg; r++)
{

IDCData(m_msgbox[r]);
Sleep(20);

IDCData(0x20);
Sleep(20);

if(IgthmsgblkR>0)

{
IDCStBlk(0xl 8, Igthmsgblk + 1, Igthmsg -1);

forfjnt r=0; Klgthmsg; r++)

{
IDCData(m_msgbox[r]);
Sleep(20);
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iffigthmsgblkR— 3)

{
for(intr=0;Kl;r++)

{
!DCData(0x20);
Sleep(20);

]
}

if(lgthmsgblkR==2)

{
forfint r=0;r<2;r++)

{
IDCData(0x20);
Sleep(20);

}
}

ifflgthmsgblkR — 1)

{
forfint r-0;r<3;r++)

{
IDCData(Ox20);
Sleep(20);

}
}

IDCData(0x20);
Sleep(250);

Sleep(250);

IDCStBlkfOxAA, 0x00, OxAA);
IDCData(0x20);
Sleep(50);
_outp(CONTROL, 0x03);
SleepflOO);
_outp(CONTROL, 0x02);

void C!DCParallel4Dlg::IDCStBlkfint B1k_Type, int BlkJMo, int Byte_No)

{
IDCInfo(Blk_Type);
Sleep(20);
IDCInfo(BlkJNo);
Sleep(20);
IDCInfo(Byte_No);
Sleep(250);
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